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Getting Started
Welcome

Thank you for choosing Garmin nRoute!

Garmin nRoute is an application designed to use Garmin GPS technology integrated with a laptop or
portable computer to provide you with navigational guidance.  You can use nRoute to:

• Create waypoints, routes, and tracks to help you navigate;

• Find items, addresses, and Points of Interest included in the map data;

• Gather information about your travels, including average speed, trip duration, etc.; and,

• Import and export data as .mps files.

WARNING:  Do not attempt to enter route information or adjust this device while driving.  Failure to pay
full attention to the operation of your vehicle could result in death, serious injury, or property damage.  You
assume total responsibility and risk for using this software.

This Help system provides you with basic instructions on how to use the features of nRoute.
NOTE:  The graphics in this Help system are optimized for monitor displays set at 1024 x 768 screen
resolution.  Viewing this help system at resolution settings other than 1024 x 768 may result in
reduced image quality.

Your nRoute packaging includes a Setup Guide to help you install the software and set up your
system properly.

If you should encounter any difficulty while installing nRoute, or if you have any questions about
nRoute, contact Garmin’s Product Support Department at:

913-397-8200 or 800-800-1020, Monday – Friday, 8am – 5pm Central Time

www.garmin.com

For more information on getting started with nRoute, see the following topics:

Important Information
How Do I...
Understanding the Interface
Unlocking Maps
Connecting the GPS Receiver
Checking Satellite Status
Setting Preferences
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Important Information
Copyright Statement

© Copyright 2004 Garmin Ltd. or its subsidiaries

Garmin International, Inc.
1200 East 151st Street, Olathe, Kansas  66062, U.S.A.
Tel. 913/397.8200 or 800/800.1020
Fax 913/397.8282

Garmin (Europe) Ltd.
Unit 5, The Quadrangle, Abbey Park Industrial Estate, Romsey, SO51 9DL, U.K.
Tel. 44/0870.8501241
Fax 44/0870.8501251

Garmin Corporation
No. 68, Jangshu 2nd Road, Shijr, Taipei County, Taiwan
Tel. 886/2.2642.9199
Fax 886/2.2642.9099

All rights reserved.  Except as expressly provided herein, no part of this manual may be reproduced,
copied, transmitted, disseminated, downloaded or stored in any storage medium, for any purpose
without the express prior written consent of Garmin.  Garmin hereby grants permission to download
a single copy of this manual onto a hard drive or other electronic storage medium to be viewed and to
print one copy of this manual or of any revision hereto, provided that such electronic or printed copy
of this manual must contain the complete text of this copyright notice and provided further that any
unauthorized commercial distribution of this manual or any revision hereto is strictly prohibited.

Information in this document is subject to change without notice.  Garmin reserves the right to
change or improve its products and to make changes in the content without obligation to notify any
person or organization of such changes or improvements.  Visit the Garmin web site
(www.garmin.com) for current updates and supplemental information concerning the use and
operation of this and other Garmin products.

Garmin® and MapSource® are registered trademarks and nRoute is a trademark of Garmin Ltd. or its
subsidiaries and may not be used without the express permission of Garmin.

Applebee's is a registered trademark of Applebee's International, Inc.

Hilton is a registered trademark of Hilton Hospitality, Inc.

Olive Garden is a registered trademark of Darden Corporation.

Texaco is a registered trademark of ChevronTexaco Corporation.

Cautions and Warnings

CAUTION:  Use the GPS receiver at your own risk.  To reduce the risk of unsafe operation, carefully
review and understand all aspects of this Owner’s Manual—and thoroughly practice operation using
the simulator mode prior to actual use.  When in actual use, carefully compare indications from the
GPS receiver to all available navigation sources, including the information from other NAVAIDs,
visual sightings, charts, etc.  For safety, always resolve any discrepancies before continuing navigation.
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CAUTION:  It is the user’s responsibility to use this product prudently.  This product is intended to
be used only as a navigational aid and must not be used for any purpose requiring precise
measurement of direction, distance, location or topography.  This product should not be used as an
aid to determine ground proximity for aircraft navigation.

CAUTION:  The electronic chart is an aid to navigation and is designed to facilitate the use of
authorized government charts, not replace them.  Only official government charts and notices to
mariners contain all information needed for safe navigation – and, as always, the user is responsible
for their prudent use.

WARNING:  The Global Positioning System (GPS) is operated by the United States government,
which is solely responsible for its accuracy and maintenance.  The system is subject to changes which
could affect the accuracy and performance of all GPS equipment.  Although the Garmin GPS receiver
is a precision electronic NAVigation AID (NAVAID), any NAVAID can be misused or misinterpreted
and, therefore, become unsafe.

WARNING:  For use in vehicles, it is the sole responsibility of the owner/operator of the GPS
receiver to secure the unit so that it will not interfere with the vehicle’s operating controls, obstruct
the driver’s view of driving conditions, or cause damage or personal injury in the event of an accident.
Do not mount the GPS receiver over air bag panels or in the field of air bag deployment.  Air bags
expand with a rapid force that can propel objects in their path toward the driver or passengers
causing possible injury.  Refer to air bag safety precautions contained in the vehicle’s owner manual.
Do not mount the GPS receiver in a place where the driver or passengers are likely to impact it in an
accident or collision.  The mounting hardware provided by Garmin is not warranted against collision
damage or the consequences thereof.

WARNING:  For use in vehicles, it the sole responsibility of the driver of the vehicle to operate the
vehicle in a safe manner, maintain full surveillance of all driving conditions at all times, and not
become distracted by the GPS receiver to the exclusion of safe driving practices.  It is unsafe to
operate the controls of the GPS receiver while you are driving.  Failure by the driver of a vehicle
equipped with a GPS receiver to pay full attention to operation of the vehicle and road conditions
while the vehicle is in motion could result in an accident or collision with property damage and
personal injury.

WARNING:  This product, its packaging, and its components contain chemicals known to the State
of California to cause cancer, birth defects, or reproductive harm.  This Notice is being provided in
accordance with California’s Proposition 65.  If you have any questions or would like additional
information, please refer to our web site at http://www.garmin.com/prop65.

Map Data Information

One of the goals of Garmin is to provide customers with the most complete and accurate cartography
that is available to us at a reasonable cost.  We use a combination of governmental and private data
sources, which we identify as required in product literature and copyright messages displayed to the
consumer.  Virtually all data sources contain inaccurate or incomplete data to some degree.  This is
particularly true for areas outside the United States, where complete and accurate digital data is either
not available, or is prohibitively expensive.

If the data source is lacking a feature, or an item is mislocated or misidentified, it will be incorrectly
identified or missing in the Garmin cartography product as well.  Each Garmin cartography product
has its strengths and weaknesses, and not all are suitable for every purpose.  Please keep this in mind
as you use and enjoy the benefits the cartography provides.
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Garmin encourages customers to report any errors found in our electronic maps by completing our
on-line Error Reporting Form in the Cartography section of our web site at:
http://www.garmin.com/cartography/mapSource/errorForm.html.

CAUTION:  GARMIN MAKES NO WARRANTY AS TO THE ACCURACY OR COMPLETENESS OF
THE MAP DATA IN THIS PRODUCT AND DISCLAIMS ANY AND ALL EXPRESS, IMPLIED, OR
STATUTORY WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE.  IT IS THE USER’S RESPONSIBILITY TO USE THIS
PRODUCT PRUDENTLY.  THIS PRODUCT IS INTENDED TO BE USED ONLY AS A TRAVEL AID
AND MUST NOT BE USED FOR ANY PURPOSE REQUIRING PRECISE MEASUREMENT OF
DIRECTION, DISTANCE, LOCATION OR TOPOGRAPHY.

Software Agreement

THIS SOFTWARE IS OWNED BY GARMIN LTD OR ITS SUBSIDIARIES (HEREINAFTER
COLLECTIVELY REFERRED TO AS "GARMIN") AND IS PROTECTED UNDER COPYRIGHT LAWS
AND INTERNATIONAL COPYRIGHT TREATIES. THIS SOFTWARE IS LICENSED, NOT SOLD.
THIS SOFTWARE IS PROVIDED UNDER THE FOLLOWING LICENSE WHICH DEFINES WHAT
YOU MAY DO WITH THE PRODUCT AND CONTAINS LIMITATIONS ON WARRANTIES AND/OR
REMEDIES.

IMPORTANT: CAREFULLY READ THIS LICENSE BEFORE USING THIS PRODUCT. INSTALLING,
COPYING, OR OTHERWISE USING THIS PRODUCT INDICATES YOUR ACKNOWLEDGMENT
THAT YOU HAVE READ THIS LICENSE AND AGREE TO ITS TERMS. IF YOU DO NOT AGREE,
RETURN THE COMPLETE PRODUCT TO Garmin INTERNATIONAL. INC. PRODUCT SUPPORT,
1200 EAST 151st STREET, OLATHE, KS 66062 WITHIN 10 DAYS OF THE DATE YOU ACQUIRED
IT FOR A FULL REFUND.

1. LICENSE: Garmin ("we" or "us") provides you with storage media containing computer software
(the "Program") which may also include digital cartographic data and "online" or electronic
documentation, and printed materials (together called the "Product") and grants you a limited non-
exclusive license to use the Product in accordance with the terms of this License Agreement. The
copyright and all other rights to the Product shall remain with us. You must reproduce any copyright
or other notice marked on the Product on all copies you make.

2. YOU MAY: a) install and use one copy of the Product on a single computer or network. This copy
is to be used by only a single user at a time. If you wish to use the Product for more users, you will
need an additional license for each user.

b) make one copy of the Product for archive or backup purposes.

c) use a copy of the Product on a home or portable computer if that copy is never loaded at the same
time it is loaded on your primary computer.

d) transfer the Product to someone else only if you assign all of your rights under this License, cease
all use of the Product, erase or destroy any copy (including the hard disk copy) made in support of
your use of  the Product, and ensure that the other person agrees to the terms of this License.

3. YOU MUST NOT: a) make copies of the Product except as expressly permitted in Section 2 of this
License.
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b) translate, reverse engineer, decompile, or disassemble the Product except to the extent the
foregoing  restriction is expressly prohibited by applicable law.

c) rent, lease, loan, sub-license, distribute, assign, or transfer the Product except as set out in Section
2 (d) above.

d) modify the Product or merge all or any part of the Product with another program.

4. TERM: This License shall continue for as long as you use the Product. However, this License will
terminate automatically without notice from Garmin if you fail to comply with any of its terms or
conditions. You must agree, upon termination, to destroy all copies of the Product. The Limitations of
Warranties and Liability set out below shall continue in force even after any termination.

5. LIMITATION OF WARRANTIES AND LIABILITY: THE PRODUCT IS PROVIDED ON AN "AS IS"
BASIS, WITHOUT ANY WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABLE QUALITY, MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE, OR THOSE ARISING BY LAW, STATUTE, USAGE OF
TRADE, OR COURSE OF DEALING. THE ENTIRE RISK AS TO THE RESULTS AND
PERFORMANCE OF THE PRODUCT IS ASSUMED BY YOU. NEITHER WE NOR OUR DEALERS
OR SUPPLIERS SHALL HAVE ANY LIABILITY TO YOU OR ANY OTHER PERSON OR ENTITY FOR
ANY INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES WHATSOEVER,
INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, LOST OR DAMAGED
DATA OR OTHER COMMERCIAL OR ECONOMIC LOSS, EVEN IF WE HAVE BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES, OR THEY ARE FORESEEABLE. WE ARE ALSO NOT
RESPONSIBLE FOR CLAIMS BY A THIRD PARTY. OUR MAXIMUM AGGREGATE LIABILITY TO
YOU SHALL NOT EXCEED THE AMOUNT PAID BY YOU FOR THE PRODUCT. THE
LIMITATIONS IN THIS SECTION SHALL APPLY WHETHER OR NOT THE ALLEGED BREACH OR
DEFAULT IS A BREACH OF A FUNDAMENTAL CONDITION OR TERM OR A FUNDAMENTAL
BREACH. SOME STATES/COUNTRIES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATION
MAY NOT APPLY TO YOU.

6. RESTRICTED RIGHTS: If this Product is acquired by or for the U.S. Government, then it is
provided with Restricted Rights. Use, duplication, or disclosure by the U.S. Government is subject to
restrictions as set forth in subparagraph (c)(1)(ii) of The Rights in Technical Data and Computer
Software clause at DFARS 252.227-7013, or subparagraphs (c)(1) and (2) of the Commercial
Computer Software - Restricted Rights at 48 CFR 52.227-19, or clause 18-52.227-86(d) of the NASA
Supplement to the FAR, as applicable. The contractor/manufacturer is Garmin International, Inc.,
1200 E. 151st Street, Olathe, KS 66062, USA.

7. EXPORT CONTROLS: You agree not to export or re-export the Product to any country in violation
of the export control laws of the United States of America.

8. GENERAL: This License is the entire agreement between us, superseding any other agreement or
discussions, oral or written, and may not be changed except by a signed agreement. This License shall
be governed by and construed in accordance with the laws of the State of Kansas, United States of
America. If any provision of this License is declared by a court of competent jurisdiction to be invalid,
illegal, or unenforceable, such a provision shall be severed from the License and the other provisions
shall remain in full force and effect.
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Consumer Limited Warranty

This Garmin product is warranted to be free from defects in materials or workmanship for one year
from the date of purchase.  Within this period, Garmin will at its sole option, repair or replace any
components that fail in normal use.  Such repairs or replacement will be made at no charge to the
customer for parts or labor, provided that the customer shall be responsible for any transportation
cost.  This warranty does not cover failures due to abuse, misuse, accident or unauthorized alteration
or repairs.

THE WARRANTIES AND REMEDIES CONTAINED HEREIN ARE EXCLUSIVE AND IN LIEU OF
ALL OTHER WARRANTIES EXPRESS OR IMPLIED OR STATUTORY, INCLUDING ANY LIABILITY
ARISING UNDER ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE, STATUTORY OR OTHERWISE.  THIS WARRANTY GIVES YOU SPECIFIC LEGAL
RIGHTS, WHICH MAY VARY FROM STATE TO STATE.

IN NO EVENT SHALL GARMIN BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT OR
CONSEQUENTIAL DAMAGES, WHETHER RESULTING FROM THE USE, MISUSE, OR INABILITY
TO USE THIS PRODUCT OR FROM DEFECTS IN THE PRODUCT.  Some states do not allow the
exclusion of incidental or consequential damages, so the above limitations may not apply to you.

Garmin retains the exclusive right to repair or replace the unit or software or offer a full refund of the
purchase price at its sole discretion.  SUCH REMEDY SHALL BE YOUR SOLE AND EXCLUSIVE
REMEDY FOR ANY BREACH OF WARRANTY.

To obtain warranty service, call your local Garmin authorized dealer.  Or call Garmin Product
Support at one of the numbers listed on the right for shipping instructions and an RMA tracking
number.  The unit should be securely packed with the tracking number clearly written on the outside
of the package.  The unit should be sent, freight charges prepaid, to any Garmin warranty service
station.  A copy of the original sales receipt is required as the proof of purchase for warranty repairs.

Online auction confirmations are not accepted for warranty verification.  To obtain warranty service,
an original or copy of the sales receipt from the original retailer is required.  Garmin will not replace
missing components from any package purchased through an online auction.
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How Do I...
This Help topic is designed to provide you with quick instructions on how to perform common
nRoute tasks.

…Hook Up the GPS Receiver?

See Connecting the GPS Receiver.  Your nRoute Setup Guide also contains information on connecting
your GPS receiver.

…Know the GPS is Receiving?

Press F11 to activate the Satellites Tab to verify that the GPS is receiving.  See Checking Satellite
Status for more information.

…Find Myself on the Map?

Click the Keep Vessel Visible  button to center the map on your current location.  See Showing
the Vehicle on the Map for more information.

…Move the Map Around?

Use the Hand tool  or the scroll bars at the bottom and right-hand side of the screen to move the
map.  You can also zoom in and out to show portions of the map not currently displayed.

…Change the Way the Map Looks?

Select Preferences from the Edit menu, then click on the Display tab.  From there, you can change
many features of the map display, including the amount of visible detail.  See Setting Display
Preferences for more information.

To change the orientation of the map, click the Change Map Orientation button .  See
Changing Map Orientation for more information.

…Switch Maps?

If you have multiple products installed, select the desired map from the Product list

.  It may be necessary to unlock the desired map if you have not already
done so.  NOTE: If you don't have additional maps installed, the Product list is not displayed.  See
Unlocking Maps for more information.

…Find Addresses, Intersections, or Items on the Map?

Click the Find Places button , select the type of item you want to find from the Find Places
window, then enter the desired information.  See Understanding the Find Feature for more
information.
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…Get Driving Directions to My Current Route Destination?

When you have a route active, you can get driving directions using the following methods:

• Check the InfoBar above the Graphic Map for the next maneuver along the route.

• Press F9 to activate the Driving Directions Tab for a list of all the maneuvers along the active
route.

…Get Driving Directions for a Saved Route?

Right-click on the route you want to get directions for, select Route Properties from the right-click
menu, and click on the Driving Directions tab. See Editing a Route for more information.

…Get the Voice to Speak?

Press the Space Bar or click the Speak button  in the Utilities Toolbar. If you have a route
activated, nRoute gives you voice instructions for the next maneuver.  If you do not have a route
activated, nRoute tells you the satellite status.

…Deactivate a Route?

Click the Stop Route button  in the Routes Toolbar.  See Activating and Deactivating a Route for
more information.

…Track my Travel?

Click on the Tracks Tab (F6) and check the Record Track box  in the lower right-
hand corner.  See Recording a Track for more information.

…Save Waypoints, Routes, or Tracks so I Can Open Them in MapSource?

Select Export MapSource File from the File Menu, enter a file name, select the desired location on
your computer to save the MapSource file, and click Save.  Your waypoints, routes, and tracks are
saved as a MapSource file with the extension .mps.  See Saving Your Data for more information.

…Delete Waypoints, Routes, Tracks, or Favorite Finds?

Select the item to be deleted in the appropriate Information Tab, then click the Delete button .
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Understanding the Interface
The main nRoute interface screen consists of the following items:

Menus – A variety of menus are displayed at the top of the screen.  These menus allow you to
perform various tasks in nRoute, including activating toolbars, changing preferences for viewing the
Graphic Map, creating and editing routes, and more.  See Menus in the Reference section for more
information.

Toolbars – Toolbars are displayed near the top of the screen, directly below the menus.  You can
toggle the toolbars on and off by selecting Toolbars in the View menu, then selecting the desired
toolbar.  See Toolbars in the Reference section for more information.

InfoBar – The InfoBar is displayed above the Graphic Map.  While you are navigating, the InfoBar
contains information about the next upcoming maneuver along your route.  See Using the InfoBar for
more information.

Graphic Map – The Graphic Map is nRoute's main navigation tool.  nRoute displays the basemap
and any detailed maps you have installed.  The Graphic Map shows your current location (indicated
by the Vessel icon), a map of the surrounding area, and any waypoints, routes, or tracks you have
created and activated.  See Understanding the Graphic Map for more information.

Information Tabs – The Information Tabs are displayed along the bottom of the screen.  The
Information Tabs include Waypoints, Saved Routes, Tracks, Favorite Finds, Status, Driving
Directions, Trip Computers, and Satellites.  Click the appropriate tab to view the desired information.
You can also press the corresponding Function (F) key on your keyboard to activate a tab.  Press F12
on your keyboard to show/hide all the Information Tabs.

Click on items in the Information Tabs to activate them on the Graphic Map, or right-click on an item
to display a menu that allows you to perform various tasks.  See Right-Click Menus in the Reference
section for more information.

Status Bar – The Status Bar is displayed in the lower left-hand corner of the screen.  When you
move the mouse cursor across the screen, the Status Bar tells you the latitude and longitude of the
map location the mouse cursor is pointing at.  When you select a waypoint in the Waypoints Tab, the
Status Bar tells you the distance from your current location to that waypoint.



10

Unlocking Maps

nRoute utilizes a basemap and detailed maps installed from MapSource products.  The type of
detailed map data available depends on the map product(s) installed.  In order to access detailed map
data, you must have the appropriate map product(s) installed and unlocked.  If you have multiple
MapSource products installed and unlocked on your computer, you can use many of them with
nRoute.  NOTE:  nRoute cannot be used with BlueChart or MetroGuide 5.

Your MapSource product contains instructions on how to install and unlock detailed maps.

When you open nRoute, the application automatically detects whether or not you have unlocked the
maps installed on your computer.

To unlock a MapSource product:

1. Select Unlock Regions from the Utilities Menu.  The Unlock Region window is displayed.

2. Click on the region you want to unlock, then click the Add button.  The Add Unlock Region window is
displayed.

3. Enter the appropriate unlock code and, if desired, a comment about the region, then click OK.  The region is
unlocked and can be used with nRoute.

To switch MapSource products:

If you have more than one MapSource product installed, you can select the desired MapSource
product from the Product selector

.
NOTE:  If you have only one MapSource product installed, the Product selector is not displayed.
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Connecting the GPS Receiver
Many features of nRoute will work even if the GPS receiver is disconnected.  However, in order for
nRoute to accurately perform some functions, the GPS receiver must be connected and receiving
signals from GPS satellites.

To connect the GPS receiver:

1. Plug the GPS receiver into the appropriate port (serial or USB) on your computer.

• If you have never used nRoute before, click Select Device , select the appropriate port (serial or
USB), and click OK.  If you are using a serial GPS, you can click AutoDetect to have nRoute
automatically detect the device.

• If you have used nRoute before, but without a GPS receiver connected, nRoute prompts you to select a
receiver.  Select the appropriate device (serial or USB) and click OK.

• If you have previously connected the GPS receiver to your computer using nRoute, nRoute begins to
acquire satellites and the message "Searching for Satellites" is displayed in the InfoBar.

• If you are using a serial GPS receiver, verify that it is plugged in to the vehicle's 12-volt receptacle and is
receiving power.

• If there is a discrepancy between the GPS receiver's clock and the clock on your PC, nRoute prompts you
to select the correct time.  If you select GPS, nRoute changes the clock on your PC to match the GPS
receiver's time.  NOTE:  The GPS receiver's time is not necessarily correct if you are connecting it for the
first time or if it hasn't been used for a while.

When you connect your GPS receiver for the first time, or if you have traveled more than 600 miles with the
receiver turned off, the initialization process may take as long as 15 minutes to determine your location.

To shorten the initialization time, click the Selection tool , right-click on your approximate location on
the Graphic Map, and select Set Current Location.

2. After a few moments, nRoute acquires satellites and the message "Ready to Navigate" is displayed in the
InfoBar.  See Checking Satellite Status for more information.

NOTE:  If you are using a serial GPS receiver on a computer with a Windows operating system, you
may experience erratic mouse movements.  This is because Windows may be identifying your GPS
receiver as a serial mouse.  If this happens, follow the steps below:

1. Unplug the serial GPS.

2. From the desktop, right-click the My Computer icon and select 'Properties'.

3. Click the Hardware tab, then click Device Manager (in Windows 98, click the Device Manager tab).

4. Double-click 'Mice and other pointing devices'.

5. Right-click on 'Serial ballpoint mouse' and select Disable.

6. Close the Device Manager.

A sensor configuration program is available on the Garmin web site to further configure your GPS
receiver.  See the GPS 18 Tech Specs document (also available on the Garmin web site) for more
information.
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Checking Satellite Status
After connecting your GPS receiver, you can check the Satellites Tab to verify that your GPS receiver
is acquiring satellites.  The Satellites Tab is displayed along the bottom of the screen.  It shows the
satellites your GPS receiver has acquired, their signal strength, the accuracy of navigation, and your
current position.  You can activate the Satellites Tab by clicking on it or pressing F11 on your
keyboard.

nRoute can utilize WAAS (Wide Area Augmentation System), provided your GPS receiver is enabled
to receive WAAS satellites.  WAAS technology is a system of satellites and ground stations that
provide GPS signal corrections, giving you better position accuracy.  WAAS is most effective in the
U.S.A.  If you are located in another part of the world, it is recommended that you turn off WAAS for
the most accurate location fix.  See What is WAAS? on the Garmin web site for more information.

The Satellites Tab contains the following features:

Connection Status – The Connection Status field contains information about the type of signal that
your GPS receiver is receiving.  If your GPS receiver is not connected, the message "Attempting
Connection to Unit" is displayed.  When your GPS receiver is connected, the message "Searching for
Satellites" is displayed.  Depending of the number of satellites your GPS receiver receives, the type of
connection is displayed.

Poor GPS Coverage – Your GPS receiver is receiving fewer than three GPS satellites and cannot
determine your location accurately.

2D Navigation – Your GPS receiver is receiving three GPS satellites and has determined your 2D
location (latitude and longitude).

2D Differential – Your GPS receiver is receiving three GPS satellites, one of which is a WAAS
satellite.

3D Navigation – Your GPS receiver is receiving four or more GPS satellites and has determined
your 3D location (latitude, longitude, and elevation).

3D Differential – Your GPS receiver is receiving four or more satellites and has determined your
3D location (latitude, longitude, and elevation) with WAAS enabled.

GPS Satellite Location View – These large white circles show the positions of satellites in the sky
overhead, with the center of the circles representing your current position.  The outer circle indicates
the horizon; the inner circle indicates a position 45° from the horizon.  The small, numbered circles
indicate the satellites and the numbers assigned to them.  These small circles turn green to indicate
that a satellite is being used to determine your location.  Yellow indicates a satellite has been located
but is still initializing, and is not yet being used to determine your location.  White indicates that no
signals are being received.

Accuracy – The accuracy of the GPS system.
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Enable/Disable WAAS – Enable WAAS to increase the accuracy of your GPS system, or disable
WAAS for faster initialization, to preserve battery power, or if WAAS is not available in your area.  See
What is WAAS? on the Garmin web site for more information.

Time/Date – The current time and date.

Position – Your current position in latitude and longitude.

GPS Signal Strength – This graph indicates the strength of the GPS signal being received from each
corresponding numbered satellite.  Satellites numbered 32 and below are GPS satellites, while
satellites numbered greater than 32 are WAAS satellites.

nRoute will automatically attempt to acquire satellites if you have a GPS unit connected to your
computer.  If your GPS receiver does not acquire satellites:

• Make sure your GPS receiver is connected properly to your computer.  See Connecting the GPS
Receiver for more information.

• Verify that your GPS receiver is unobstructed. Solid materials (except untinted glass), tall
buildings, and dense overhead tree cover can block satellite signals. In order to receive satellite
signals, you must be outdoors or in a vehicle and have a clear view of the sky.

• Make sure the GPS receiver has enough time to initialize. When the GPS receiver initializes for the
first time, or if you have traveled more than 600 miles with the GPS receiver turned off, the
initialization process may take as long as 15 minutes.

• If you are using a serial GPS receiver, verify that it is plugged in to the 12v recepticle and is
receiving power.

• Try disconnecting the GPS receiver from your PC and reconnecting it.

• Try closing and re-opening nRoute.

• Try uninstalling and re-installing nRoute.
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Setting Preferences
You can use the Preferences window to customize many features of nRoute to suit your needs.  To
access the Preferences window, select Preferences from the Edit Menu or press Ctrl+Shift+P on
your keyboard.

There are nine tabs in the Preferences window: Display, InfoBar, Units, Position, Waypoint, Time,
Find, Navigation, and Routing.  Each tab contains several fields that allow you to adjust your
preferences.

Display Tab – The Display Tab allows you to customize the way the Graphic Map is displayed,
including the level of map detail, visible routes, and colors.  See Setting Display Preferences for more
information.

InfoBar Tab – The InfoBar Tab allows you to customize the information displayed in the first and
second fields of the InfoBar.  See Using the InfoBar for more information.

Units Tab - The Units Tab allows you to select the type of units used for a variety of measurements.
The Units Tab contains the following fields:

Distance/Speed - Select Metric, Nautical, or Statute.  All distance or speed measurements reflect
this setting.

Heading - Choose True, Automatic Magnetic Variation, User Magnetic Variation, Grid, or
Cardinal Direction. ‘True’ displays true north headings.  ‘Automatic’ automatically calculates the
magnetic variation for the geographical area.  ‘Grid’ provides a true north heading as determined
by the Position Format.  When ‘User’ is selected, the field to the right is activated for manual entry
of a magnetic variation. When 'Cardinal Direction’ is selected, your heading and/or course is
displayed as N(orth), S(outh), E(ast) and W(est), etc. (Course information is found in the Saved
Routes Tab).

Altitude/Elevation - Select Feet or Meters

Depth - Select Feet, Meters or Fathoms
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Area - Select Acres, Hectares, Square Feet, Square Miles, Square Meters, or Square Kilometers.

Position Tab - Select from available grid formats or manually enter information for a user-defined
grid.  The Position Tab contains the following fields:

Grid - Select a grid format from the drop-down list.  Refer to the "Using a Garmin GPS with
Paper Maps" manual available at www.garmin.com.

Datum - Select from over 100 available map datums, allowing nRoute to easily match up with
just about any paper chart or map, or manually enter information for a user defined map datum.

Waypoint Tab - Allows you to change your preferences for creating waypoints.  See Setting
Waypoint Preferences for more information.

Time Tab - Sets up displayed time, either by the computer’s local time zone, or by manually entering
a UTC offset (hours different from Greenwich Mean Time).

Find Tab - This allows you to set the maximum number of places nRoute should find when
searching for a particular feature, and set the maximum number of "Recently Found" places you want
nRoute to remember.  See Setting Find Preferences for more information.

Navigation Tab – Sets preferences for active navigation, including voice-prompts and route
recalculation.  The Navigation tab contains the following features:

Guidance Prompt Selector – Allows you to select how far away from a maneuver you want the
voice prompt to speak.  Move the slider towards 'Less distance' if you want to hear voice prompts
closer to the maneuver.  Move the slider towards 'More distance' if you want to hear voice
prompts when you are farther away from the maneuver (giving you more time to prepare for the
maneuver).

Voice Prompt – Select 'Speak Button Only' to hear voice prompts only when you click the
Speak button or press the Space Bar on your keyboard.  Select 'Route Guidance' to hear voice
prompts for the next maneuver in an active route.  Select 'Route Guidance and Status' to hear
voice prompts for the next maneuver in the active route as well as voice prompts about satellite
signals.

Attention Tone – Allows you to activate an attention tone that will sound on alerts or other
messages from nRoute even if voice prompts are turned off.

Off-Route Recalculation – Select 'Automatic with Voice Alert' for nRoute to automatically
recalculate routes and play a voice prompt announcing the recalculation, 'Automatic without
Voice Alert' for automatic recalculation without a voice prompt, 'Ask Me' for nRoute to ask you to
if you want to recalculate, or 'Off' to recalculate routes only when you click the Recalculate
button.

Routing Tab - Sets preferences for automatic routing calculations.  Select auto-routing or direct
route.  See Setting Route Preferences for more information.
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Using the Graphic Map
Understanding the Graphic Map
The Graphic Map is nRoute's main navigation tool.  nRoute displays the basemap and any detailed
maps you select in MapSource.  The basemap contains major cities, roads, and highways, while
detailed maps contain smaller streets, addresses, intersections, and Points of Interest.

The Vessel icon  indicates your position and heading on the Graphic Map.  Active routes are
displayed as colored lines on the map.  Waypoints are displayed by symbol and by name.  Points of
Interest are displayed as symbols.  The names of some Points of Interest are displayed on the map in a
different font than waypoint names.

Graphic Map Tips

• To view the name of a Point of Interest, click on the Selection Tool , then hold the mouse
cursor over the desired Point of Interest on the map.

• If there are multiple items at a single location on the Graphic Map, right-click on the location,
then select the desired item from the list that is displayed.

• You can perform a variety of tasks by right-clicking on the Graphic Map.  See Map Feature Right-
Click Menu for more information.

• The Information Tabs across the bottom of the screen show waypoints, routes, and tracks.  To
display an item on the Graphic Map, right-click on the item and select 'Show Selected Item on
Map'.

• Click the Keep Vessel Visible button  to center the Vessel icon on the map.

• Click the Keep Maneuver Visible button  to show the next maneuver on the map while you
are navigating on a route.
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• If you move the map, zoom in or out, or display a different area on the Graphic Map while the
Keep Vessel Visible and/or Keep Next Maneuver Visible buttons are selected, nRoute
automatically deselects those buttons so that you can manipulate the map as needed.  After you
have finished manipulating the map, click the Keep Vessel Visible and/or Keep Maneuver
Visible buttons again to re-activate. See Showing the Vehicle on the Map for more information.

• The Graphic Map can be oriented to display in either 'North Up' or 'Track Up' mode.  See
Changing Map Orientation for more information.

• You can change the color of the text and the background of the Graphic Map by setting your
display preferences.

For more information on the Graphic Map, see the following topics:

Setting Display Preferences

Moving the Graphic Map

Zooming In and Out on the Map

Showing the Vehicle on the Map

Changing Map Orientation

Using the InfoBar

Using the Status Tab

Using the Trip Computers Tab

Saving Your Data

Opening Saved Data

Legend: Businesses and Attractions

Legend: Points of Interest

Legend: Map Lines

Legend: Map Areas
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Setting Display Preferences
You can customize the way the Graphic Map is displayed, including the level of map detail, visible
routes, and colors.

To set display preferences:

1. Select Preferences from the Edit Menu.  The Preferences window is displayed.

2. Click the Display tab.  The Display Preferences tab is displayed.

3. Make the desired changes to the following fields:

Map Detail – Click and drag to adjust the amount of detail (streets, Points of Interest, waypoints, etc.)
displayed on the Graphic Map.

Services – Use this option to display services and Points of Interest if they are loaded as part of your
detailed maps.  Select 'Automatic' to display these items when the map is zoomed in to a low scale.  Select
'On' to display these items regardless of the map zoom scale.  Select 'Off' if you don't want these items
displayed.

Colors – This item changes the color of the text and background of the Graphic Map and the Information
Tabs.  Select 'Day' for a light background with darker text, 'Night' for a dark background with lighter text, or
'Automatic' to automatically switch between the Day and Night settings at the appropriate time of day.

Lock to Roads – Select 'On' to keep the Vessel icon attached to the nearest road on the map, or select
'Off' to allow the Vessel icon to go off-road.

Show Tracks – Select 'All' to show all tracks, 'Active' to show only the active track, or 'None' to show no
tracks.

Show Routes – Select 'All' to show all saved and active routes or 'Active' to show only the active route.

Vessel Size – Select the size you want the vessel (Vessel icon) displayed on the Graphic Map.

Change Map Font – Click on this button to select a new font, style, and size for map text.

4. Click OK to save your changes.
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Moving the Graphic Map
There are several methods for moving (or "panning") the Graphic Map to view portions of the map
not currently displayed on the screen:

• Click the Hand Tool , move the mouse cursor over the Graphic Map, then click and hold the
left mouse button and move the mouse in the direction you want to move the Graphic Map.

• Click the Zoom Tool , move the mouse cursor over the Graphic Map, then hold down the
Ctrl key while clicking and holding the left mouse button and move the mouse in the direction
you want to move the Graphic Map.

• Use the scroll bars on the right side and at the bottom of the Graphic Map.

• Click on any point on the Graphic Map, then use the Up, Down, Left, and Right arrow keys on
the keyboard to move the map short distances.  Hold down the Ctrl key while pressing the arrow
keys to move longer distances.

You can also zoom in and out to view portions of the map not currently displayed on the screen.  See
Zooming In and Out on the Map for more information.
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Zooming In and Out on the Map
The more you zoom in on the Graphic Map, the more details (streets, map features, Points of Interest,
etc.) are displayed. (NOTE: You can set the amount of detail displayed on the Graphic Map by using
the Display Preferences window.)

There are several methods for zooming in and out on the Graphic Map:

• Click the Zoom In  and Zoom Out  buttons.

• Select the desired map scale using the Map Scale Selector  .

• Click the Zoom tool , move the mouse cursor over the Graphic Map, then click and hold the
left mouse button and move the mouse cursor to draw a box around the area you want to zoom in
on.  The smaller the box, the more the map will zoom in.

With the Zoom Tool selected, you can also click the left mouse button to zoom in incrementally
and the right mouse button to zoom out incrementally.

• Select Zoom Scale from the View Menu, then select the desired map scale.

• Press the Plus (+) and Minus (-) keys on the number pad of your keyboard to zoom in and out.

You can also move the map to view portions of the map not currently displayed on the screen.  See
Moving the Graphic Map for more information.
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Showing the Vehicle on the Map
You can set nRoute to keep your vehicle (shown by the Vessel icon) visible on the map while you are
navigating along a route.  In addition, you can set nRoute to automatically zoom in and out on the
map so that you can see the next maneuver along the route.

• Click the Keep Vessel Visible button  to center the Vessel icon on the map.  If you leave this
button selected, the Vessel icon will stay visible on the map as you navigate along the route.

• Click the Keep Next Maneuver Visible button  to automatically show the next maneuver
while navigating along a route.

• Click both buttons or press Ctrl+B to keep the Vessel icon visible on the map and automatically
zoom in and out to show the next maneuver along the route.

NOTE:  If you move the map, zoom in or out, or display a different area on the Graphic Map while
either the Keep Vessel Visible and/or Keep Next Maneuver Visible buttons are selected, nRoute
automatically deselects those buttons so that you can manipulate the map as needed.  After you have
finished manipulating the map, click the Keep Vessel Visible and/or Keep Maneuver Visible
buttons again to re-activate.
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Changing Map Orientation
The Graphic Map can be oriented to display in either 'North Up' or 'Track Up' mode.

North Up means North is always towards the top of the screen.  When you turn, your Vessel icon
turns to indicate which direction you are heading.

Track Up orients the Graphic Map in the direction of travel with the Vessel icon always pointing
towards the top of the screen.  When you turn, the Graphic Map redraws the map to show which
direction you are heading, but the Vessel icon remains pointed towards the top of the screen.  In
Track Up mode, an arrow is displayed in the upper left-hand corner of the Graphic Map indicating
which way is North.

There are three ways to change map orientation:

• Click the Change Map Orientation button  in the View toolbar;

• Select Change Orientation in the View menu, or;

• Press Ctrl+O.

NOTE:  If you move the map, zoom in or out, or display a different area on the Graphic Map while in
Track Up mode, nRoute automatically stops redrawing the map so that you can manipulate the map
as needed.  After you have finished manipulating the map, change the map orientation to North Up,
then back to Track Up to re-activate Track Up mode.
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Using the InfoBar
The InfoBar is displayed above the Graphic Map.  You can resize the InfoBar by clicking on its bottom
border and dragging it up or down.

The InfoBar displays the following messages:

• If you do not have a GPS unit connected to your computer, the InfoBar displays the message
"Attempting connection to GPS."

• If you have an active route but do not have a GPS unit connected, the InfoBar displays the
message "Please connect GPS to start route".

• If you have a GPS unit connected, but it has not acquired satellites, the InfoBar displays the
message "Searching for satellites".

• If you have a GPS unit connected and it has acquired satelltes, the InfoBar displays the message
"Ready to Navigate".

• While you are navigating along an active route, the InfoBar contains information about the next
maneuver on your route, including the estimated distance and time to the next maneuver.

• If you do not have a route active, the InfoBar defaults to display your current heading and speed,
as well as the upcoming cross street.

You can customize the information displayed in the InfoBar by changing InfoBar Preferences.

To change InfoBar preferences:

1. Select Preferences from the Edit Menu, then click on the InfoBar tab.  The InfoBar Preferences window is
displayed.
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2. Select the desired options for the information displayed in the two rightmost fields while routing (navigating
with an active route):

Accuracy – Shows the accuracy of the GPS.

Dist (Destination) – Shows the distance to your destination.

Dist (Maneuver) – Shows the distance to the next maneuver.

Elevation – Shows your current elevation.

ETA (Destination) – Shows the estimated time of arrival at your destination.

ETA (Maneuver) – Shows the estimated time of arrival at the next maneuver.

Heading – Shows your current heading.

Speed – Shows your current speed.

Time (Destination) – Shows the total time remaining until you reach your destination.

Time (Maneuver) – Shows the total time remaining until the next maneuver.

Time of Day – Shows the current time of day.

3. Select the desired options for the information displayed in the two rightmost fields while not routing (no
active route):

Accuracy – Shows the accuracy of the GPS.

Elevation – Shows your current elevation.

Heading – Shows your current heading.

Speed – Shows your current speed.

Time of Day – Shows the current time of day.

4. Click OK to save your changes.
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Using the Status Tab
The Status Tab shows your current speed, direction, and elevation.  You can access the Status Tab by
clicking on it or pressing F8 on your keyboard.

The Status Tab includes the following features:

Speed – Your current speed.

Heading – Your current heading.

Elevation – Your current elevation.

Address – The street address closest to your current location.

Next Street – The next cross street you are approaching.

Compass – The red line indicates North.  The green line at the top of the compass indicates your
current heading.  When you are navigating on a direct route, a black arrow showing the direction to
the next waypoint is displayed on the compass.  See Understanding Routes for more information.

Dist (Maneuver) – The estimated distance to the next maneuver in the route.

Dist (Destination) – The estimated distance to the end of the route.

Time (Maneuver) – Shows the total time remaining until the next maneuver.

Time (Destination) – Shows the total time remaining until you reach your destination.

ETA (Maneuver) – The estimated time of day you will arrive at the next maneuver.

ETA (Destination) – The estimated time of day you will arrive at the end of the route.
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Using the Trip Computers Tab
The Trip Computers Tab keeps track of your speed, time, and mileage while you are navigating.  You
can access the Trip Computers Tab by clicking on it or pressing F10 on your keyboard.

You can have multiple trip computers running at the same time, and each can be stopped and started
individually.  For example, you can have multiple trip computers recording information for a trip
across the country, starting a different trip computer for each leg of the trip while your original trip
computer keeps track of the trip as a whole.

The Trip Computers Tab contains the following features:

Trip Name – The name of the trip computer that is currently displayed.  If you want to continue a
previous trip, click the drop-down arrow and select the desired trip.

Trip Odometer – The total mileage you have accumulated on the trip.

Avg Speed – Your average speed during trip, including stopped time.

Driving Avg – Your average speed while your vehicle is in motion during the trip (does not include
stopped time).

Max Speed – Your maximum speed during the trip.

Moving Time – The total time your vehicle was in motion during the trip.

Stopped Time – The total time your vehicle was stopped during the trip.

Trip Time – The total time elapsed during your trip.

Reset – Click to reset all the above fields to zero.

Start/Stop – Click to start and stop the trip computer.

New – To start a new trip, click this button, enter the name for your new trip, and click OK.  The trip
computer is reset, and the name of the new trip is displayed in the Trip Name field.

Delete – To delete the active trip, click this button, then click OK.  The active trip is deleted.
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Saving Your Data
Data in nRoute is automatically saved and will be loaded whenever you start nRoute.  Any waypoints,
routes, and tracks you have created using nRoute can also be saved as .mps files on your computer.
These files can be used to back up your data or share data with Garmin MapSource.

To save waypoints, routes, and tracks:

1. Select Export File from the File Menu.

2. Enter a file name and select the desired location on your computer to save the file.

3. Click Save.  The file is saved with the extension .mps.
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Opening Saved Data
You can open saved .mps files in nRoute, importing waypoints, routes, and tracks from the saved file.
When you open a saved .mps file, nRoute merges the saved data with your current data.

To open a saved .mps file:

1. Select Import File from the File Menu.

2. Browse to the desired .mps file on your computer.

3. Click Open.  The file opens in nRoute.
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Legend of Map Symbols
Legend: Businesses and Attractions
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Legend: Points of Interest
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Legend: Map Lines
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Legend: Map Areas
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Creating Waypoints
Understanding Waypoints
A waypoint is a location that you mark on the map. It can be an address, an intersection, an existing
map feature or point of interest, an empty spot on the map, or any other point you wish.  You can use
waypoints to mark your favorite places – places you visit frequently, like your favorite restaurant, a
friend's house, etc.

You can mark waypoints directly on the map or by using the Find feature. nRoute allows you to set
your waypoint preferences to change the default method for displaying waypoints.  You can also edit
waypoint properties after they have been marked.

Waypoints are shown on the map and in the Waypoints Tab at the bottom of the screen.  Select a
waypoint in the Waypoints Tab to highlight the waypoint on the Graphic Map.

Waypoint Tips

• To center a waypoint on the Graphic Map, right-click on the waypoint in the Waypoints Tab and
select 'Show Selected Waypoint on Map'.

• You can perform a variety of tasks by right-clicking on a waypoint in the Waypoints Tab.  See
Waypoint Right-Click Menu for more information.

• Your waypoints are stored in memory for future use.  You can also save waypoints in an .mps file.
See Saving Your Data for more information.

For more information on waypoints, see the following topics:

Using the Waypoints Tab

Setting Waypoint Preferences

Marking Waypoints

Editing Waypoint Properties

Moving Waypoints

Deleting Waypoints
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Using the Waypoints Tab
The Waypoints Tab shows a list of all the waypoints you have created.  You can access the Waypoints
Tab by clicking on it or pressing F4 on your keyboard.

You can perform a variety of tasks by right-clicking on a waypoint in the list.  See Waypoint Right-
Click Menu for more information.

You can edit waypoint information using the Waypoint Properties window.  See Editing Waypoint
Properties for more information.

The Waypoints Tab contains the following fields:

Name – The name of the waypoint.

Symbol – The waypoint symbol that is displayed on the Graphic Map.

Description – A description of the waypoint.  The description defaults to the date and time the
waypoint was created.

Position – The latitude and longitude of the waypoint.

Altitude – The altitude of the waypoint.

Display – Describes how the waypoint is displayed on the Graphic Map: Symbol, Symbol & Name,
or Symbol & Description.

To re-order the waypoints in the list, click on the name of the field you wish to sort the list by (for
example, if you want to sort the list by waypoint name, click on the Name field).
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Setting Waypoint Preferences
You can change the character limit for waypoint names as well as the default settings for creating
waypoints, including the name prefix, symbol, and how the waypoint is displayed on the map.

To set waypoint preferences:

1. Select Preferences from the Edit Menu.  The Preferences window is displayed.

2. Click the Waypoint tab.  The Waypoint Preferences tab is displayed.

3. Make any desired changes to the following fields:

Limit application created names to XX characters - Enter the desired number of characters or click
the drop-down arrow to select a number.  This option is useful if you are sending waypoints to another GPS
unit that only accepts limited character names.

Name Prefix - Enter the desired prefix you want displayed in front of waypoint names.  The Example Name
field changes to reflect the prefix you enter.

Symbol - Select the desired symbol you want to use to mark waypoints on the map.

Display - Select the desired method for displaying waypoints on the map: Symbol, Symbol & Name, or
Symbol & Description.

4. If you want to use these new settings when creating waypoints, select 'Use the choices above'.  If you want
to use the default settings when creating waypoints, select 'Let application decide its name, symbol, and
display'.

5. Click OK to save your changes.
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Marking Waypoints
You can mark waypoints by clicking on any point on the Graphic Map.  You can use the Find feature
to find cities, addresses, intersections, or Points of Interest, then mark those items as waypoints.  You
can also mark your current location as a waypoint.

To mark a waypoint on the Graphic Map:

1. Click the Waypoint Tool button .

2. Click the desired location on the Graphic Map.  The Waypoint Properties window is displayed.  See Editing
Waypoint Properties for more information.

3. Enter the desired waypoint properties and click OK.  The waypoint is displayed on the map and in the
Waypoints Tab at the bottom of the screen.

To mark a waypoint using the Find feature:

1. Find the desired item using the Find feature.

2. Click the Make Waypoint button in the Find window. The Waypoint Properties window is displayed.  See
Editing Waypoint Properties for more information.

3. Enter the desired waypoint properties and click OK.  The waypoint is displayed on the map and in the
Waypoints Tab at the bottom of the screen.

To mark your current location as a waypoint:

1. Click the Mark Current Position button . The Waypoint Properties window is displayed.  See Editing
Waypoint Properties for more information.

2. Enter the desired waypoint properties and click OK.  The waypoint is displayed on the map and in the
Waypoints Tab at the bottom of the screen.
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Editing Waypoint Properties
The Waypoint Properties window allows you to edit waypoints and customize the way they are
displayed on the map.  To activate the Waypoint Properties window, do one of the following:

• Click the Selection Tool , then double-click the desired waypoint on the Graphic Map.

• Double-click the desired waypoint name in the Waypoints Tab.

• Click the desired waypoint in the Waypoints Tab or on the Graphic Map, then Waypoint
Properties from the Edit Menu.

• Right-click the desired waypoint in the Waypoints Tab or on the Graphic Map, then select
Waypoint Properties from the right-click menu.

The Waypoint Properties window is displayed.

The Waypoint Properties window contains the following features:

Name – Enter a name for the waypoint, if desired.  The default name is a sequential number, plus any
prefix you entered in the Waypoint Preferences window.

Symbol – Select the desired symbol to display on the map.  See Map Legend – Symbols for a list of
available symbols.

Description – Enter a description to identify the waypoint, if desired.  If you create a waypoint on an
existing map feature, nRoute includes the name of the feature in the Description field.  If you create a
waypoint on an open location, the Description field defaults to the date and time the waypoint was
created.

Position – The coordinates of the waypoint.  You can enter new coordinates to change the position of
the waypoint, if desired.

Altitude – Enter an altitude or leave the default Unknown box checked.

Display – Select the method for displaying the waypoint on the map: symbol, symbol & name, or
symbol & description.  You can change the default display setting in the Waypoint Preferences
window.

Route To It – Generates a route to the waypoint.  See Understanding Routes for more information.

Show on Map – Centers the Graphic Map on the selected waypoint.
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Moving Waypoints

You can move an existing waypoint to a new location on the Graphic Map.

To move a waypoint:

1. Click the Selection Tool .

2. Right-click on the desired waypoint on the Graphic Map, then select Move Waypoint.  A small waypoint
icon and a curved arrow are displayed next to the mouse cursor.

3. Click on the new location on the map.  The waypoint moves to the new location.

NOTE: You can also move a waypoint by changing its coordinates in the Position field of the
Waypoint Properties window.



39

Deleting Waypoints
There are multiple methods to delete a waypoint from the Waypoints Tab:

• Click on the desired waypoint and click the Delete button .

• Right-click on the desired waypoint and select Delete Waypoint from the right-click menu.

• Click on the desired waypoint and select Delete Waypoint from the Edit Menu.

• Click on the desired waypoint and press the Delete key on your keyboard.

If you delete a waypoint by mistake, click the Undo button  or select Undo from the Edit Menu.
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Using the Find Feature
Understanding the Find Feature
The Find feature allows you to search for any Map Feature (addresses, waypoints, Points of Interest,
etc.) and create a route to it.  All Find Items are part of the basemap (which contains major cities) and
detailed map data (which contains addresses, map features, and Points of Interest).  The type of
detailed map data available depends on the map product(s) installed.  See Unlocking Maps for more
information.

Find Feature Tips

• Click the Find Places button  to locate cities, map features/Points of Interest, addresses,
intersections, and waypoints.  You can find items by entering the item's name (if known) and by
selecting categories to find certain types of items.  This feature provides you with an ordered list
of items that meet your search criteria.  See Finding Cities, Finding Map Features/Points of
Interest, Finding Addresses, Finding Intersections, and Finding Waypoints for more information.

• Click the Find Nearest button  to locate items near your current location.  This feature lists
items based on how close they are to you.  You can select categories to find certain types of items
and also use the 'Containing' field to find an item based on all or part of the item's name.  See
Finding Items Near Your Current Location for more information.

• Click the Recently Found Places button  to view a list of the last few items you found.
nRoute keeps track these items case you want to find them again quickly.  See Finding Recently
Found Places for more information.

• You can save your Favorite Finds to create a list of items you commonly search for and find these
items quickly.  See Understanding the Favorite Finds Feature for more information.

For more information on the Find feature, see the following topics:

Setting Find Preferences

Finding Cities

Finding Map Features/Points of Interest

Finding Addresses

Finding Intersections

Finding Waypoints

Finding Items Near Your Current Location

Finding Recently Found Places

Finding a Latitude/Longitude Position

Understanding the Favorite Finds Feature
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Setting Find Preferences
You can change the number of items displayed in the Find list and in the Recently Found Places list
by setting your Find preferences.

To set find preferences:

1. Select Preferences from the Edit Menu.  The Preferences window is displayed.

2. Click the Find tab.  The Find Preferences tab is displayed.

3. Make any desired changes to the following fields:

Show this many found places – Enter the number of items you want displayed in the Find list when you
are searching for an item.

Remember this many found places – Enter the number of items you want displayed in the Recently
Found Places list.

Show this many Find Places Auto Complete results – Enter the number of items you want to appear
in the Auto Complete list when you are entering information in the Find Places window.

4. Click OK to save your changes.
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Finding Cities
Major cities are part of the basemap loaded on your computer.

To find a city:

1. Click the Find Places button , then click the City tab.

2. If you want to clear information previously entered on this screen, click the Reset button.

3. Enter the name of the city in the City field.  As you type, an Auto Complete list of nearest matches is
displayed below the field.  You may type the entire name of the city or type the first few letters and select
the name from the list.

4. Enter the State/Province and Country to refine your search, if desired.

5. Click the Find button.  A list of cities is displayed in the Places field.

6. Click on the desired city in the list.  The selected city is centered on the Graphic Map.

7. After selecting the desired city, you can do any of the following:

• To mark the city as a waypoint, click Make Waypoint.  The Waypoint Properties window is displayed.
See Editing Waypoint Properties for more information.

• To create a route to the city, click Route To It.  nRoute generates a route from your current location to
the selected city.

• To close the Find Places window and leave the selected city centered on the Graphic Map, click OK.

• To close the Find Places window and return to the previous map display, click Cancel.
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Finding Map Features / Points of Interest
Map features and Points of Interest are contained in detailed mapping data.

To find map features/Points of Interest:

1. Click the Find Places button , then click the Feature tab.

2. If you want to clear information previously entered on this screen, click the Reset button.

3. Select the desired Place Category and, if desired, Place Subcategory.

4. If you know the name of the Point of Interest you want to find, enter the name in the Name field.  As you
type, an Auto Complete list of nearest matches is displayed below the field.  You may type the entire name
of the Point of Interest or type the first few letters and select the name from the list.

5. Enter the City, State/Province, and Country to refine your search, if desired.

6. Click the Find button.  A list of Points of Interest is displayed in the Places field.

7. Click on the desired Point of Interest in the list.  The selected Point of Interest is centered on the Graphic
Map.

8. After selecting the desired Point of Interest, you can do any of the following:

• To view the address and telephone number of the Point of Interest, click the Properties button.

• To mark the Point of Interest as a waypoint, click Make Waypoint.  The Waypoint Properties window
is displayed.  See Editing Waypoint Properties for more information.
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• To create a route to the Point of Interest, click Route To It.  nRoute generates a route from your
current location to the selected Point of Interest.

• To close the Find Places window and leave the selected Point of Interest centered on the Graphic Map,
click OK.

• To close the Find Places window and return to the previous map display, click Cancel.
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Finding Addresses
Addresses are contained in detailed mapping data.

To find an address:

1. Click the Find Places button , then click the Address tab.

2. If you want to clear information previously entered on this screen, click the Reset button.

3. Enter the Number of the address.

4. Click the Select button next to the Street field, then enter the desired street name (or street number)
without any prefix or suffix.  For example, to find 'N 140th Street', enter '140th'.

5. Select the desired street from the list, then click Select Street.

6. If you want your search to cover only a specific area, enter the desired City, State/Province, Postal Code,
and/or Country.

7. Click the Find button.  A list of addresses is displayed in the Places field.

8. Click on the desired address in the list.  The selected address is centered on the Graphic Map.

9. After selecting the desired address, you can do any of the following:

• To mark the address as a waypoint, click Make Waypoint.  The Waypoint Properties window is
displayed.  See Editing Waypoint Properties for more information.

• To create a route to the address, click Route To It.  nRoute generates a route from your current
location to the selected address.

• To close the Find Places window and leave the selected address centered on the Graphic Map, click OK.

• To close the Find Places window and return to the previous map display, click Cancel.
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Finding Intersections
Intersections are contained in detailed mapping data.

To find an intersection:

1. Click the Find Places button , then click the Intersection tab.

2. If you want to clear information previously entered on this screen, click the Reset button.

3. Click the Select button next to the First Street field, then enter the desired street name (or street number)
without any prefix or suffix.  For example, to find "N 140th Street", enter "140th".

4. Select the desired street from the list, then click Select Street.

5. Click the Select button next to the Second Street field, then enter the desired street name (or street
number).

6. Select the desired City, State/Province, Postal Code, and/or Country to refine your search, if desired.

7. Click the Find button.  A list of intersections is displayed in the Places field.

8. Click on the desired intersection in the list.  The selected intersection is centered on the Graphic Map.

9. After selecting the desired intersection, you can do any of the following:

• To mark the intersection as a waypoint, click Make Waypoint.  The Waypoint Properties window is
displayed.  See Editing Waypoint Properties for more information.

• To create a route to the intersection, click Route To It.  nRoute generates a route from your current
location to the selected intersection.

• To close the Find Places window and leave the selected intersection centered on the Graphic Map, click
OK.

• To close the Find Places window and return to the previous map display, click Cancel.
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Finding Waypoints
You can use the Find feature to find any waypoints you have created.  See Marking Waypoints for
more information.

To find a waypoint:

1. Click the Find Places button , then click the Waypoint tab.

2. Enter the name of the waypoint in the Name field.  As you type, an Auto Complete list of nearest matches
is displayed below the field.  You may type the entire name of the waypoint or type the first few letters and
select the name from the list.

3. Click the Find button.  A list of waypoints is displayed in the Places field.

4. Click on the desired waypoint in the list.  The selected waypoint is centered on the Graphic Map.

5. After selecting the desired waypoint, you can do any of the following:

• To view the properties of the waypoint, click the Properties button.  The Waypoint Properties window
is displayed.  See Editing Waypoint Properties for more information.

• To create a route to the waypoint, click Route To It.  nRoute generates a route from your current
location to the selected waypoint.

• To close the Find Places window and allow the selected waypoint to remain centered on the Graphic
Map, click OK.

• To close the Find Places window and return to the previous map display, click Cancel.
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Finding Items Near Your Current Location
If your GPS receiver is connected and has acquired satellites, nRoute allows you to find Points of
Interest near your current location.  If your GPS receiver is not connected or has not acquired
satellites, nRoute finds items near your last known location.

You can find items near your current location by selecting the desired Place Categories and
Subcategories.  If you know the name of the item you are looking for, you can quickly find it by
entering all or part of the name of the item in the Containing field.

To find items near your current location:

1. Click the Find Nearest button .  The Find Nearest Places window is displayed.

2. Select the desired Place Category and, if desired, Place Subcategory.

3. Enter the Maximum Search Distance in miles.  This is the radius of your search area from your current
location.

4. Enter the name (or part of the name) of the Point of Interest in the Containing field, if desired.  For
example, to find the nearest Texaco gas station, enter "Texaco" in the Containing field.

5. Click the Find button.  A list of Points of Interest is displayed in the Places field.

6. Click on the desired Point of Interest in the list.  The selected Point of Interest is centered on the Graphic
Map.

7. After selecting the desired Point of Interest, you can do any of the following:

• To add the item to your Favorite Finds, click Save as Favorite.  The Favorite Find Properties window is
displayed.  See Adding an Item to Your Favorite Finds for more information.

• To view the address and telephone number of the Point of Interest, click the Properties button.
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• To mark the Point of Interest as a waypoint, click Make Waypoint.  The Waypoint Properties window
is displayed.  See Editing Waypoint Properties for more information.

• To create a route to the Point of Interest, click Route To It.  nRoute generates a route from your
current location to the selected Point of Interest.

• To close the Find Nearest Places window and leave the selected Point of Interest centered on the
Graphic Map, click OK.

• To close the Find Nearest Places window and return to the previous map display, click Cancel.
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Finding Recently Found Places
nRoute keeps track of items you recently found in case you want to find them again quickly.

To find recently found items:

1. Click the Recently Found Places button .  The Recently Found Places window is displayed.

2. Click on the desired item in the list.  The selected item is centered on the Graphic Map.

3. After selecting the desired item, you can do any of the following:

• To view the address and telephone number of the item, click the Properties button.

• To mark the item as a waypoint, click Make Waypoint.  The Waypoint Properties window is displayed.
See Editing Waypoint Properties for more information.

• To create a route to the item, click Route To It.  nRoute generates a route from your current location to
the selected item.

• To close the Recently Found Places window and leave the selected item centered on the Graphic Map,
click OK.

• To close the Recently Found Places window and return to the previous map display, click Cancel.
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Finding a Latitude/Longitude Position
You can find a position on the Graphic Map by entering the desired latitude and longitude.

To find a latitude/longitude position:

1. Select Go To Position from the View Menu.  The Go To Position window is displayed.

2. Enter the desired latitude and longitude and click OK.  The Graphic Map centers on the position you
entered.
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Using the Favorite Finds Feature
Understanding the Favorite Finds Feature
The Favorite Finds feature allows you to save your Find Nearest Places search criteria.  You can use
the Favorite Finds feature to create a list of "favorites" -- items you commonly search for -- and find
these items quickly.

Favorite Finds store Category, Subcategory, and Maximum Search Distance information so that you
don't have to re-enter the data each time you wish to find an item.  You can also specify your Favorite
Finds by name.  For example, you can create Favorite Finds to locate the nearest Texaco gas station or
Hilton hotel.

Items you add to your Favorite Finds are displayed in the Favorite Finds Tab at the bottom of the
screen.  nRoute also includes some default Favorite Finds such as 'Nearest Fast Food', 'Nearest Gas
Station', 'Nearest Hospital', and 'Nearest Coffee Shop'.  You can modify or delete these default
Favorite Finds as desired.

For more information on the Favorite Finds feature, see the following topics:

Using the Favorite Finds Tab

Adding an Item to Your Favorite Finds

Finding an Item Using the Favorite Finds Feature

Editing a Favorite Find

Deleting a Favorite Find
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Using the Favorite Finds Tab
The Favorite Finds Tab lists all the Favorite Finds you have saved.  You can access the Favorite Finds
Tab by clicking on it or pressing F7 on your keyboard.

You can perform a variety of tasks by right-clicking on items in the Favorite Finds tab.  See Favorite
Finds Right-Click Menu for more information.

The Favorite Finds Tab includes the following fields:

Name – The term or phrase used to describe the Favorite Find.  NOTE:  nRoute does not use
information entered in this field when finding the item.

Type – The category of items the Favorite Find searches for (Food & Drink, Services, All Points of
Interest, etc.)

Subtype – The subcategory of items the Favorite Find searches for (Hotels, Auto Fuel, All
Subcategories, etc.)

Distance – The radius of your search area from your current location.

Containing – All or part of the name of the item you want the Favorite Find to search for.
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Adding an Item to Your Favorite Finds

To add an item to your Favorite Finds:

1. Select New Favorite Find from the Find Menu.  The Favorite Find Properties window is displayed.

2. Enter an appropriate descriptive term or phrase for your Favorite Find, i.e. "Nearest Gas Station", "Nearest
Italian Restaurant", "Nearest Applebee's", etc.  NOTE:  nRoute does not use the name entered in this field
when finding the item.  If you want nRoute to find an item by name, enter the name of the item in the
Containing field.

3. Select the appropriate Place Category and, if desired, Place Subcategory.

4. Enter the Maximum Search Distance in miles.  This is the radius of your search area from your current
location.

5. If you want nRoute to find the item by name, enter the name of the item in the Containing field, i.e.
"Texaco", "Olive Garden", "Applebee's", etc.

6. Click OK.  The item is saved and is displayed in the Favorite Finds Tab.

You can also add a Point of Interest to your Favorite Finds directly from the Find Nearest Places
window.  See Finding Items Near Your Current Location for more information.
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Finding an Item Using the Favorite Finds Feature

To find an item using the Favorite Finds feature:

1. Right-click on the desired item in the Favorite Finds Tab and select Activate Favorite Find.  A Find
Nearest Places window containing the Favorite Find information is displayed.  The nearest Points of Interest
matching your Favorite Find criteria are displayed in the Places field.

2. Click on the desired Point of Interest in the list.  The selected Point of Interest is centered on the Graphic
Map.

3. After selecting the desired Point of Interest, you can do any of the following:

• To view the address and telephone number of the Point of Interest, click the Properties button.

• To mark the Point of Interest as a waypoint, click Make Waypoint.  The Waypoint Properties window
is displayed.  See Editing Waypoint Properties for more information.

• To create a route to the Point of Interest, click Route To It.  nRoute generates a route from your
current location to the selected Point of Interest.

• To close the Find Nearest Places window and leave the selected Point of Interest centered on the
Graphic Map, click OK.

• To close the Find Places window and return to the previous map display, click Cancel.
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Editing a Favorite Find
You can edit the information in the default Favorite Finds as well as the Favorite Finds you create.

To edit a Favorite Find:

1. Right-click on the desired item in the Favorite Finds Tab and select Favorite Find Properties.  The
Favorite Find Properties window is displayed.

2. Make the desired changes to the Favorite Find and click OK.  Your changes are saved.
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Deleting a Favorite Find
There are multiple methods to delete a Favorite Find from the Favorite Finds Tab:

• Click on the desired Favorite Find and click the Delete button .

• Right-click on the desired Favorite Find and select Delete Favorite Find from the right-click
menu.

• Click on the desired Favorite Find and select Delete Favorite Find from the Edit Menu.

• Click on the desired Favorite Find and press the Delete key on your keyboard.
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Routing
Understanding Routes
nRoute can generate a route from your current location to one or more waypoints, addresses,
intersections, Points of Interest, or any other points on the map.  nRoute displays the active route as a
colored line on the Graphic Map.  The beginning point of a route is displayed in green and the route
destination is displayed in red.

The InfoBar and voice prompts inform you of upcoming maneuvers along the route and your arrival
at the route destination.  nRoute also generates text-based driving directions to help you navigate.

After you have created a route, you can use the Route Properties window to edit the route as desired,
adding, removing, or changing the order of the points along the route.

Route Tips:

• Press the Space Bar or click the Speak button  to activate the voice prompt.

• nRoute generates a list of driving directions for each route.  You can view this list by clicking the
Driving Directions Tab at the bottom of the screen or by pressing F9.  See Using the Driving
Directions Tab for more information.

• The Status Tab provides you with information about the route and navigation tools to help you
reach your destination.  See Using the Status Tab for more information.

• When you go off-course from an active route, nRoute automatically recalculates the route from
your current position.

• You can also click the Recalculate Route button  to manually recalculate the route at any
time.

• Routes remain active until you deactivate them or activate a new route.  See Activating and
Deactivating a Route for more information.

• If there is a route active when you close nRoute, the route will be reactivated the next time you
open nRoute.

• In addition to auto-routes (automobile routes that follow streets and highways), nRoute allows
you to create direct routes (straight line, "as the crow flies" routes).  See Setting Route Preferences
for more information.
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• Routes you have created and saved are displayed in the Saved Routes Tab along the bottom of the
screen and stored in memory for future use. You can also save routes in an .mps file.  See Saving
Your Data for more information.

• You can create routes containing multiple points, called Vias.  See Creating a Saved Route Using
the Route Properties Window for more information.

• The Route Menu and Route Toolbar both contain shortcuts that allow you to perform many of the
tasks described in this chapter.

For more information on routes, see the following topics:

Setting Route Preferences

Creating a Route Using the Selection Tool

Creating a Route Using the Find Places Feature

Creating a Saved Route Using the Route Properties Window

Creating a Direct Route

Saving an Active Route

Using the Saved Routes Tab

Activating and Deactivating a Route

Using the Driving Directions Tab

Editing a Route

Deleting a Route
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Setting Route Preferences
You can modify route preferences to change the route style, calculation style, types of roads to avoid,
and many other aspects of your routes.

To set route preferences:

1. Select Preferences from the Edit Menu, then click the Routing tab.  The Route Preferences tab is
displayed.

2. Make the desired changes to the following fields:

Route Style – select 'Use Auto-Routing' to generate turn-by-turn automotive routes that follow the streets
and highways on your map.  Select 'Use Direct Routes' to generate straight-line, "as the crow files" routes.

Calculation Style – select 'Faster Time' or 'Shorter Distance'.  NOTE: 'Faster Time' routes usually utilize
highways instead of side streets.

Vehicle – select the desired vehicle from the list (bicycle, car, pedestrian, truck, etc.).

Try to Avoid – select the types of roads and maneuvers you want nRoute to avoid incorporating into your
route.

Driving Speeds – select your average driving speeds for each type of road.  This helps nRoute estimate
your driving time when generating a route and select the best route according to your driving habits.  To
reset the speeds to the default numbers, click Reset.

3. Click OK to save your changes.
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Creating a Route Using the Selection Tool
You can create an active route to any single point on the Graphic Map using the Selection Tool.

To create a route using the Selection Tool:

1. Click the Selection Tool .

2. Right-click on the item or point on the Graphic Map that you want to route to, then select Route To It from
the right-click menu.  The route is created, activated, and displayed on the Graphic Map.  Driving Directions
are automatically generated.

NOTE: Routes created using this method are not automatically saved in the Saved Routes Tab at the bottom
of the screen.  See Saving an Active Route for more information.
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Creating a Route Using the Find Places Feature
You can create an active route to any city, address, intersection, waypoint, or Point of Interest using
the Find Places, Find Nearest, or Recently Found Places features.  All Find Items are part of the
basemap (which contains major cities) and detailed mapping data downloads (which contain
Addresses, Map Features, and Points of Interest).

To create a route using the Find Places feature:

1. Click the Find Places , Find Nearest , or Recently Found Places  button.

2. Find the desired item.  See Understanding the Find Feature for more information.

3. When the desired item is displayed in the Find list, click on it, then click Route To It.  The route is created,
activated, and displayed on the Graphic Map.  Driving Directions are automatically generated.

NOTE: Routes created using this method are not automatically saved in the Saved Routes Tab at the bottom
of the screen.  See Saving an Active Route for more information.
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Creating a Saved Route Using the Route Properties Window
The Route Properties window allows you to create and edit routes containing one or more points (or
"Vias").  It allows you to find addresses, intersections, waypoints, and Points of Interest and place
them in the route in any order you wish.  You can also add, remove, and rearrange items in your
route.

After you create the route, you can activate it or save it.

To create a saved route using the Route Properties window:

1. Select New Saved Route from the Edit menu.  The Route Properties window is displayed.

2. Add Via points to the route using the following methods:

• Click the Find Places , Find Nearest , or Recently Found Places  button in the toolbar,
find the desired item, and click Add to Route.  See Understanding the Find Feature for more
information.

• Click Insert Waypoint, select the desired waypoint, and click OK.

3. Edit the route as necessary.  See Editing a Route for more information.

• If you want to view driving directions for the route, click the Directions tab.  From the Directions tab,
you can print a list of directions by clicking Print Directions.

4. After you have finished creating the route, do one of the following:

• If you want to save and activate the route, click the Activate button.  The route is activated and
displayed on the Graphic Map.  It is also automatically saved and displayed in the Saved Routes Tab at
the bottom of the screen.
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• If you want to save the route without activating it, click OK.  The route is created and automatically
named using the first and last waypoints.  The route is displayed in the Saved Routes Tab at the bottom
of the screen.

NOTE:  You may receive a message saying that the selection will not be visible because of the current
preference setting.  Click Yes to change your display preferences to show all routes on the Graphic
Map, or click No to exit without changing your preferences.  See Setting Display Preferences for more
information.
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Saving an Active Route
Routes created using the Selection Tool or the Find Places feature are not automatically saved.

To save an active route:

1. Select Save Active Route from the Route Menu.  The route is displayed in the Saved Routes Tab.  The
default route name is 'Saved Active Route'.

2. Change the route name, if desired.  See Editing a Route for more information.
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Using the Saved Routes Tab
The Saved Routes Tab lists all the saved routes you have created using the Route Properties Window,
as well as any active routes you have saved.

You can access the Saved Routes Tab by clicking on it or pressing F5 on your keyboard.

You can perform a variety of tasks by right-clicking on a route in the list.  See Saved Routes Right-
Click Menu for more information.

The Route Tab contains the following features:

Name – The name of the route.

Length – The total length of the route.

Time – The estimated time required to navigate the route.

Course – The directional heading for the route.

Waypoints – The number of waypoints and/or via points included in the route.

To re-order the routes in the list, click on the name of the field you wish to sort the list by (for
example, if you want to sort the list by route name, click on the Name field).
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Activating and Deactivating a Route
Saved routes and new routes created using the Route Properties Window must be activated before
you can begin navigation.

To activate a saved route:

1. Click the Saved Routes Tab.

2. Right-click on the desired route and select Activate Route.  The route is displayed on the Graphic Map.
Driving Directions are automatically generated.

The route will remain active until you deactivate it or activate another route.

To deactivate a route:

1. Click the Stop Route button .  The route is deactivated.

2. To reactivate the last active route, click the Resume Route button .  The route is reactivated.
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Using the Driving Directions Tab
When you activate a route, nRoute generates a list of driving directions, including maneuvers,
estimated distance, and estimated time.  You can access the Driving Directions Tab by clicking on it
or pressing F9 on your keyboard.

The Driving Directions Tab contains the following features:

Directions/Name – Each maneuver along the route is listed in this column.  The highlighted
maneuver is displayed in the Maneuver Preview window to the right of the list.  The upcoming
maneuver in the route is also displayed in the InfoBar above the Graphic Map.

Leg Length – The estimated distance from one maneuver to the next.

Leg Time – The estimated time from one maneuver to the next.

Maneuver Preview Window – When you click on a maneuver in the list, a graphic preview of that
maneuver is displayed in the Maneuver Preview window.  An arrow is displayed in the upper left
corner of the window to indicate which direction is North.

Show Selection on Map – Click on a maneuver in the list, then click on this button to show the
selected maneuver on the Graphic Map.  The Graphic Map automatically zooms to show the
maneuver.

Show Route on Map – Click to show the entire route on the Graphic Map.  The Graphic Map
automatically zooms to show the route.

Destination – The route destination.

Remaining Distance – The estimated remaining distance to the route destination.

Remaining Time – The estimated remaining time to the route destination.
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Editing a Route
You can rename routes and print driving directions, as well as add, remove, and rearrange Via points
in a route.

To edit a route:

1. Click the Saved Routes Tab.

2. Right-click on the route you want to edit and select Route Properties.  The Route Properties window is
displayed.

3. Use the following features to edit the route as desired:

Autoname – The Autoname feature automatically names the route based on the route's starting point and
final destination.  For example, a route that begins at "Home" and ends at "113 Pine Street" is autonamed
"Home to 113 Pine Street".  To rename the route, uncheck the Autoname box and enter the desired name
in the Name field.

Directions – This tab provides you with a list of driving directions.  From the Directions tab, you can print
the list by clicking Print Directions.

Edit Toolbar – Use the buttons on this toolbar to cut, copy, paste, and delete Via points from the route, or
undo/redo the last action.

Via Point Properties Button  – Select a Via point in the list and click the Via Point Properties button
to view information about that point.

Find Places , Find Nearest , and Recently Found Places  Buttons – To add Via points to
the route using the Find Places feature, click these buttons in the toolbar, find the desired item, and click
Add to Route.  See Understanding the Find Feature for more information.
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Move Up  and Move Down  Arrows – select the desired Via point and click the Move Up or
Move Down arrows to rearrange the position of that point in the route list.

Recalculate – Recalculates the driving directions for the route.

Insert Waypoint – To insert a waypoint into the route, click this button, select the desired waypoint, and
click OK.

Invert - Inverts the order of all the Via points in the route.

Center Map on Selected Item – Check this box to show the selected Via point in the center of the
Graphic Map.

Show on Map – Shows the entire route on the Graphic Map.

4. Click OK to save your changes.
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Deleting a Route
There are multiple methods to delete a saved route from the Saved Routes Tab:

• Click on the desired route and click the Delete button .

• Right-click on the desired route and select Delete Route from the right-click menu.

• Click on the desired route and select Delete Route from the Edit Menu.

• Click on the desired route and press the Delete key on your keyboard.

If you delete a route by mistake, click the Undo button  or select Undo from the Edit Menu.



72

Using Tracks
Understanding Tracks
As you navigate with nRoute, you can record your travels as "tracks".  A track consist of information
gathered at various points along your path, including altitude, position, direction, speed, and time.
This information can then be used to help you travel back to your point of origin.  You can use the
Track Filter to set the parameters for how tracks are recorded. You can record a track whether or not
you are navigating along a route.

Tracks can be viewed on the Graphic Map, saved, and edited as desired.

Tracks you have created are shown in the Tracks Tab along the bottom of the screen and stored in
memory for future use.  You can also save tracks in an .mps file.  See Saving Your Data for more
information.

For more information on tracks, see the following topics:

Using the Tracks Tab

Setting the Active Track Filter

Recording a Track

Viewing Active Track Properties

Saving an Active Track

Editing Track Properties

Viewing a Track

Deleting a Track
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Using the Tracks Tab
The Tracks Tab shows a list of all the tracks you have recorded.  You can access the Tracks Tab by
clicking on it or pressing F6 on your keyboard.

You can perform a variety of tasks by right-clicking on a track in the list.  See Tracks Right-Click
Menu for more information.

The Tracks Tab contains the following features:

Name – The name of the track.

Points – The number of points in the track.

Start Time – The date and time you started recording the track.

Elapsed Time – The total time elapsed while the track was being recorded.

Length – The total length of the track.

Area – The total area of the track in square feet.

Avg. Speed – The average speed of the vehicle along the track.

Record Active Track – Check this box to begin recording a track.  Uncheck to stop recording.

Display Active Track Properties – Click to show the Active Track Properties window for the active
track.

Save Active Track Now – Click to save the active track and begin recording a new active track.

Active Track Filter – Click to display the Track Filter.

To re-order the tracks in the list, click on the name of the field you wish to sort the list by (for
example, if you want to sort the list by track name, click on the Name field).
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Setting the Active Track Filter
The Active Track Filter controls how often nRoute places points along a track.  nRoute records the
time as well as your position and speed at each point along the track.

To set the active track filter:

1. Click the Active Track Filter button in the lower right-hand corner of the Tracks Tab.  The Track Filter
window is displayed.

2. Select the desired option for filtering the track:

None – nRoute adds a new point to the track every second.

Time – nRoute adds a new point to the track based on the time interval that you enter.  If you enter '30
seconds', a new point is added to the track every 30 seconds.

Distance – nRoute adds a new point to the track based upon the distance that you enter. If you enter '328
feet', a new point is added to the track every 328 feet.

Automatic – nRoute adds a new point to the track to best fit the user's path.  Adjust the selector to add
more or fewer points to the track.

3. Click OK to save your changes.
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Recording a Track
You can record a track using the Tracks Tab.

To record a track:

1. Click the Tracks Tab.

2. Check the Record Track box  on the right-hand side of the Tracks Tab.  nRoute begins
recording the track.

3. To stop recording, uncheck the Record Track box.  nRoute stops recording the track.  The track is
automatically saved, and the track name is displayed in the Tracks Tab.
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Viewing Active Track Properties
You can view (but not edit or change) the properties of a track as it is being recorded.

To view active track properties:

1. Click the Tracks tab.

2. Click the Display Active Track Properties button on the right-hand side of the Tracks Tab while a track
is being recorded.  The Track Properties window is displayed for the active track.

The Track Properties window contains the following information about each point along the
track:

Index – The sequential number of the track point.

Time – The time at which the track point was recorded.

Altitude – The altitude of the track point.

Leg Length – The distance to the next track point.

Leg Time – The time elapsed until the next track point was reached.

Leg Speed – The average speed of the vehicle while travelling to the next point.

Leg Course – The course the vehicle took to the next point.

Position – The position of the track point.

3. To show the active track on the map, click the Show on Map button.

4. To center the Graphic Map on a particular track point, check the Center map on selected item(s) box
and select the desired point.

5. Click Cancel to close the Track Properties window.
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Saving an Active Track
Tracks are automatically saved when you stop recording.  However, you can save an active track and
immediately begin a new track without stopping recording.

To save an active track:

1. While a track is being recorded, click the Tracks Tab.

2. Click the Save Active Track Now button.  The track is saved, and the track name is displayed in the
Tracks Tab.  nRoute automatically begins recording a new track.
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Editing Track Properties
You can edit tracks that have been previously recorded.  This includes renaming tracks, rearranging
points in a track, and viewing a vertical profile of a track.

To edit track properties:

1. Click the Tracks Tab.

2. Right-click on the track you want to edit, then select Track Properties from the right-click menu.  The
Track Properties window is displayed.

3. Use the following features to edit the route as desired:

Edit Toolbar – Use the buttons on this toolbar to cut, copy, paste, and delete Via points from the route, or
undo/redo the last action.

Invert – Click to reverse the order of the points in the track.

Filter – Click to display the Track Filter.  See Setting the Track Filter for more information.

Show Profile – Click to display a profile of the elevation of the points in the track.

Name – Enter the desired track name.

Center map on selected item – Check the box to center the Graphic Map on any selected point in the
track.

Show On Map – Select a track point and click Show on Map to show the selected point on the Graphic
Map.

4. Click OK to save your changes.
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Viewing a Track
You can view any saved track on the Graphic Map.

To view a track:

1. Click the Tracks Tab.

2. Right-click on the track you want to view and select Show Selected Track on Map.  The selected track is
displayed on the Graphic Map.  Active tracks are displayed as yellow dotted lines; inactive tracks are
displayed as white dotted lines.

NOTE:  You may receive a message saying that the selection will not be visible because of the current
preference setting.  Click Yes to change your display preferences to show all tracks on the Graphic Map, or
click No to exit without changing your preferences.  See Setting Display Preferences for more information.

NOTE:  Route lines may cover portions of the track.  You may have to deactivate the active route in order to
view the entire track.  See Activating and Deactivating a Route for more information.



80

Deleting a Track
There are multiple methods to delete a saved track from the Tracks Tab:

• Click on the desired track and click the Delete button .

• Right-click on the desired track and select Delete Track from the right-click menu.

• Click on the desired track and select Delete Track from the Edit Menu.

• Click on the desired track and press the Delete key on your keyboard.

If you delete a route by mistake, click the Undo button  or select Undo from the Edit Menu.
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Reference
Toolbars
nRoute has six toolbars that allow you to quickly perform many of the functions available in the
menus.  You can hold your mouse pointer over any button on any toolbars to display the name of
that button.

Toolbars can be activated and deactivated from the View menu.  See View Menu for more
information.

Edit Toolbar

The Edit Toolbar contains functions of the Edit Menu. You can select the Cut, Copy and Paste
functions, Delete selected items, and Undo the last user action.  After an "undo" is performed, the
Redo button is activated, allowing you to revert to the last user action, or "redo" the "undo."  See Edit
Menu for more information.

View Toolbar

The View Toolbar contains features of the View Menu.  The View Toolbar allows you to Zoom In and
Out, select a specific Zoom Scale, keep the vessel and/or maneuver visible, and change map
orientation.

If you have multiple MapSource products installed on your PC, the Product selector is also displayed
in the View Toolbar.

.
The Product selector allows you to select a map product to display on the Graphic Map.  If you have
only one MapSource product installed, the product selector is not displayed.

See View Menu for more information.

Find Toolbar

The Find features let you search for an item and view it on the Graphic Map.  The Find buttons allow
you to Find Places, Find Nearest Places, and view Recently Found Places.  See Find Menu and
Understanding the Find Feature for more information.
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Route Toolbar

The Route Toolbar contains buttons that are useful when navigating with an active route: Stop Route,
Resume Route, and Recalculate Route.  See Route Menu and Understanding Routes for more
information.

Tools Toolbar

The Tools Toolbar contains features of the Tools Menu.  You can directly select the Selection, Zoom,
Hand, Waypoint, and Distance/Bearing Tools. See Tools Menu for more information.

Utilities Toolbar

The Utilities Toolbar contains three buttons: Mark Current Position, Select GPS, and Speak.  The
Mark Current Position button allows you to mark your current location as a waypoint.  The Select
GPS button allows you to choose the type of GPS receiver your are using.  The Speak button activates
the voice prompt.  See Utilities Menu for more information.

Undocking the Toolbars

The toolbars can be undocked and moved around the application for your convenience.  To undock a
toolbar, place the mouse pointer over an open area on the toolbar, click and hold the left mouse
button and move the toolbar to a different location.  To return a toolbar to its starting location, move
it back to the top of the application.
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Menus
nRoute contains the following menus, accessible via the Menu Bar across the top of the screen:

File Menu

Edit Menu

View Menu

Find Menu

Route Menu

Tools Menu

Utilities Menu

Help Menu
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File Menu
The File Menu contains the following options:

Import (Ctrl + I) – Allows you to select and open .mps files.  See Opening Saved Data for more
information.

Export (Ctrl + E) – Allows you to save your data as an .mps file.  See Saving Your Data for more
information.

Print (Ctrl + P) – Prints the Graphic Map to the selected scale as displayed on the screen.

Print Preview – Shows a preview of how the Graphic Map will look when printed.

Print Setup – Allows you to choose options for printing the Graphic Map.

Exit – Exits the nRoute application.
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Edit Menu
The Edit Menu contains the following options:

Undo (Ctrl + Z) – Reverts the most previous action taken by the user.

Redo (Ctrl + Y) – After an "undo" is performed, the Redo button is activated, allowing you to revert
to the action that was just "undone".

Cut (Ctrl + X), Copy (Ctrl + C), Paste (Ctrl + V) – These options work in nRoute like in many
other Windows programs.  They allow you to cut or copy data to the Windows clipboard and paste it
into different areas of nRoute or other Windows programs.

Delete Item (Del) – Deletes the selected item (waypoint, route, track, or Favorite Find).

Select All (Ctrl + A) – Selects all available items in the active Information Tab.

New Saved Route (Ctrl + R) – Displays the Route Properties window.  See Creating a Saved Route
Using the Route Properties Window for more information.

Duplicate Route – Creates a copy of the selected route in the Saved Routes Tab.  The name of the
duplicate route is the original route name with a sequential number added.  For example, if you copy
a route named "Route Home", the duplicate route name is "Route Home 1".

Properties – Activates the Properties window for the selected waypoint, route, track, or Favorite
Find.

Preferences (Ctrl + Shift + P) – Activates the Preferences window, which contains setup
information for many functions within nRoute.  See Setting Preferences for more information.
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View Menu
The View Menu contains the following options:

Show Selected Item on Map (Ctrl + D) – When Waypoints, Routes, or Tracks Tabs are selected,
this feature will display the selected item in the center of the Graphic Map.  The menu heading
changes to reflect the item(s) selected in the Information Tab.  For example, if a waypoint is selected
in the Waypoints Tab, the menu will read 'Show Selected Waypoint on Map'.

Go to Position (Ctrl + G) – Allows you to enter a latitude/longitude position to view on the
Graphic Map.  See Finding a Latitude/Longitude Position for more information.

Keep Vessel Visible (Ctrl + N) – Select this option to keep the Vessel icon centered on the map.  A
check mark next to this feature indicates that it is selected.  See Showing the Vehicle on the Map for
more information.

Keep Next Maneuver Visible (Ctrl + M) – Select this option to show the next maneuver while
navigating along a route.  A check mark next to this feature indicates that it is selected.  See Showing
the Vehicle on the Map for more information.

Keep Both Visible (Ctrl + B) – Select this option to keep both the Vessel icon and the next
maneuver visible along the route.  nRoute automatically zooms in and out to show the next
maneuver.  See Showing the Vehicle on the Map for more information.

Change Orientation (Ctrl + O) – Toggles the map orientation between North Up and Track Up.
See Changing Map Orientation for more information.

Zoom In (+) – Zooms in on the map, showing a smaller area and more detail.

Zoom Out ( - ) – Zooms out on the map, showing a larger area and less detail.

Zoom In Max (Ctrl +) – Zooms in to the smallest possible scale.

Zoom Out Region (Ctrl - ) – Zooms out and centers on the region that is currently selected.

GPS Map Detail – With this item checked, nRoute shows fully-detailed version of the map that is
loaded, including all available map information (addresses, streets, Points of Interest, etc.).
Unchecking this option shows a less-detailed version of the map, but enables faster map drawing.

Show Crosshair (Ctrl + H) – Select this option to display a crosshair indicating the center of the
Graphic Map.  A check mark next to this feature indicates that it is selected.

Product – Selects a MapSource product to display on the Graphic Map.  You can select an area from
any MapSource product that has been installed on your computer and unlocked (if required).

Zoom Scale – Allows you to select the desired Zoom Scale from a list.

Toolbars – Allows you to activate the View, Utilities, Tools, and Edit Toolbars.  You can also select
'Show All Toolbars' or 'Hide All Toolbars'.

Status Bar – Allows you to toggle the status bar at the bottom of the screen on and off.  When this
item is checked, the Status Bar is displayed.

Show Information Tabs (F12) – Allows you to toggle the Information Tabs at the bottom of the
screen on and off.  When this item is checked, the Information Tabs are displayed.
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Find Menu
The Find Menu contains the following options:

Find Places (Ctrl + F) – Enables you to search for a city, point of interest, address, intersection, or
waypoint and view it on the Graphic Map.  With some MapSource products, an Advanced ‘Find’
dialog is displayed with additional menus to help narrow your search.  See Understanding the Find
Feature for more information.

Find Nearest Places (Ctrl + Shift + F) – Allows you to find features nearest to your current
position.  See Finding Items Near Your Current Location for more information.

Recently Found Places – Activates a list of the places you have recently found using the Find
feature.  See Finding Recently Found Places for more information.

Last Found Place (F3) – Allows you to quickly select the items you most recently found in your
searches (for example, an address you just found).  You can press F3 multiple times to cycle through
the last few Recently Found Places (for example, press once for last found item, press twice for the
next-to-last item, etc).  See Finding Recently Found Places for more information.

New Favorite Find – Select this item to create a new Favorite Find.  See Understanding the Favorite
Finds Feature for more information.
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Route Menu
The Route Menu contains the following options:

To Recently Found Place – Select this option to create a route using the Recently Found Places
window.  See Finding Recently Found Places for more information.

To Nearest Place – Select this option to create a route using the Find Nearest Places window.  See
Finding Items Near Your Current Location for more information.

To Feature – Select this option to create a route using the Feature tab of the Find Places window.
See Finding Map Features for more information.

To Waypoint – Select this option to create a route using the Waypoints tab of the Find Places
window.  See Finding Waypoints for more information.

To Address – Select this option to create a route using the Address tab of the Find Places window.
See Finding Addresses for more information.

To Intersection – Select this option to create a route using the Intersection tab of the Find Places
window.  See Finding Intersections for more information.

To City – Select this option to create a route using the Cities tab of the Find Places window.  See
Finding Cities for more information.

Stop Route – This option stops (deactivates) the active route.  See Activating and Deactivating a
Route for more information.

Resume Route – This option reactivates the route you just deactivated.  See Activating and
Deactivating a Route for more information.

Recalculate – This option recalculates the active route from your current position.

Save Active Route – This option saves the active route.  See Saving an Active Route for more
information.

Activate Saved Route – Select a saved route in the Saved Routes tab, then select this option to
activate that route.  See Activating and Deactivating a Route for more information.
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Tools Menu
The Tools Menu contains the following options:

Selection (S) – Activates the Selection Tool, which allows you to select map features, waypoints, and
routes directly on the Graphic Map.

Zoom (Z) – Activates the Zoom Tool, which allows you to draw a box around the area you want to
zoom in on.  The smaller the box, the more the map will zoom in.  See Zooming In and Out on the
Map for more information.

Hand (H) – Activates the Hand Tool, which allows you to pan (move) the Graphic Map.  See Moving
the Graphic Map for more information.

Waypoint (W) – Activates the Waypoint Tool, which allows you to create waypoints by clicking on
the Graphic Map.  See Marking Waypoints for more information.

Distance/Bearing (D) – Activates the Distance/Bearing Tool, which allows you to measure the
distance and bearing from one point to another on the Graphic Map.  With the Distance/Bearing Tool
selected, click on a point on the Graphic Map, then click on the point on the map you want to find
the distance/bearing to.  The distance and bearing between the two points are shown in the Status Bar
at the bottom of the nRoute application window.  To stop using the Distance/Bearing Tool, press the
Esc key on your keyboard or select a different tool.
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Utilities Menu
The Utilities Menu contains the following options:

Select GPS (Ctrl + Shift + D) – Select this option to select the type of GPS connected to your
computer -- Serial or USB.

Rename USB GPS – Select this option to rename your USB GPS.  This option is not available for
serial GPS units.

Get GPS Information – This option provides you with the Unit ID, Unit Type, and Software
Version information for your GPS.

Unlock Regions (Ctrl + U) – Select this option to unlock additional MapSource products.  See
Unlocking Maps for more information.

Set PC Clock – Select this option to set the clock on your computer to GPS time.

Mark Current Position (Ctrl + W) – Select this option to mark your current location as a
waypoint.  See Marking Waypoints for more information.

Speak (Space Bar) – Select this option to activate the voice prompt.
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Help Menu
The Help Menu contains the following options:

Contents (F1) – Select this option to activate the nRoute online help contents.

About nRoute – Select this option to display information about the software version of nRoute that
you are using, including USB drivers (if applicable).
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Right-Click Menus
nRoute includes shortcuts to many functions of the main menus through the Right-Click Menus.
With any tool selected (except the Zoom Tool), click the right button of your mouse anywhere on the
Graphic Map and a menu of options is displayed for that feature or location.  Right-clicking on an
item in one of the Information Tabs also activates a menu of options for that item.

When there is more than one map feature at a given location (such as a waypoint that is part of a
route), a list of those features is displayed first, with the name and type of feature.  Select the desired
feature from the list, and the right-click menus for that feature is displayed.

The 'Route To It', ‘Find Nearest Places’, ‘New Waypoint’, and 'Begin Measurement’ options are default
right-click options that are available almost every time you right-click on the Graphic Map.  If your
GPS is not activated, the 'Set New Location' option is also available.  See Map Feature Right-Click
Menu for more information.

For more information, see the following topics:

Map Feature Right-Click Menu

Waypoint Right-Click Menu

Saved Routes Right-Click Menu

Tracks Right-Click Menu

Favorite Finds Right-Click Menu
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Map Feature Right-Click Menu
When you right-click on an open area or on a feature of the Graphic Map (such as a Point Of Interest
or City - not a route or track), the following menu options may be displayed:

Multiple Points – If there are multiple items at a single location on the Graphic Map, right-click on
the location and a list of all the items at that location is displayed.  Select the desired item from the list
and the normal right-click menu is displayed.

Route To It – Creates a route from your current location to the selected map location.  See
Understanding Routes for more information.

Find Nearest Places – Locates the features closest to the point you click on.  See Finding Items Near
Your Current Location for more information.

New Waypoint – Creates a new waypoint at the selected map location and accesses the ‘Waypoint
Properties’ dialog.  See Understanding Waypoints for more information.

Begin Measurement – Activates the Distance/Bearing Tool, allowing you to measure the distance and
bearing from one point to another on the Graphic Map.  With the Distance/Bearing Tool selected,
click on a point on the Graphic Map, then click on the point on the map you want to find the
distance/bearing to.  The distance and bearing between the two points are shown in the Status Bar at
the bottom of the nRoute application window.  To stop using the Distance/Bearing Tool, press the
Esc key on your keyboard or select a different tool.

Set New Location – If your GPS is not activated or has not acquired satellites, this option allows you
to set your current location to the appropriate place on the Graphic Map, which allows your GPS to
acquire satellites faster.  After your GPS acquires satellites, nRoute identifies your current location and
marks it with the Vessel icon on the Graphic Map.

Show on Map – Zooms to the selected map feature and centers it on the Graphic Map.

Feature Properties – Activates the Properties for the selected map feature, such as the address and
phone number for a Point of Interest.



94

Waypoint Right-Click Menu
When you right-click on a waypoint on the Graphic Map or in the Waypoints Tab, the following
options may be displayed:

Move Waypoint – Activates the Selection Tool and allows you to move the selected waypoint to
another location on the Graphic Map.  See Moving Waypoints for more information.

Route To It – Creates an active route to the selected waypoint from your current location.  See
Creating a Route Using the Selection Tool for more information.

Find Nearest Places – Locates the features closest to the point you click on.  See Finding Items Near
Your Current Location for more information.

New Waypoint – Creates a new waypoint at the selected map location and accesses the ‘Waypoint
Properties’ dialog.  See Understanding Waypoints for more information.

Begin Measurement – Activates the Distance/Bearing Tool, allowing you to measure the distance and
bearing from one point to another on the Graphic Map.  With the Distance/Bearing Tool selected,
click on a point on the Graphic Map, then click on the point on the map you want to find the
distance/bearing to.  The distance and bearing between the two points are shown in the Status Bar at
the bottom of the nRoute application window.  To stop using the Distance/Bearing Tool, press the
Esc key on your keyboard or select a different tool.

Remove Waypoint from Route – If the selected waypoint is included in a saved route, this option
removes the waypoint from that route.

Cut/Copy/Paste – Like the functions in the Edit Menu, these options allow you to cut, copy, and
paste waypoints.

Delete Waypoint – Deletes the selected waypoint.

Set New Location – If your GPS is not activated or has not acquired satellites, this option allows you
to set your current location to the appropriate place on the Graphic Map, which allows your GPS to
acquire satellites faster.  After your GPS acquires satellites, nRoute identifies your current location and
marks it with the Vessel icon on the Graphic Map.

Show Selected Waypoint on Map – Zooms to the selected waypoint and centers it on the Graphic
Map.

Waypoint Properties – Activates the Waypoint Properties window, allowing you to review and edit
the properties for the selected waypoint.  See Editing Waypoint Properties for more information.
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Saved Routes Right-Click Menu
When you right-click on a route name in the Saved Routes Tab, the following options are displayed:

Invert Route Section – If a route contains multiple sections, this option allows you to invert the
selected section of the route without inverting the entire route. See Editing a Route for more
information.

Activate Route – Activates the selected route.  See Activating and Deactivating a Route for more
information.

Duplicate Route – Creates a copy of the selected route in the Saved Routes Tab.  The name of the
duplicate route is the original route name with a sequential number added.  For example, if you copy
a route named "Route Home", the duplicate route name is "Route Home 1".

Invert Route – Reverses the waypoint order in the selected route.  This also reverses the route name,
if the route name is the Autoname default.  If you have renamed the route, this option will not change
the route name.  See Editing a Route for more information.

Recalculate Route – If you have modified the Autorouting Preferences in the Route Preferences
window, selecting this option recalculates the selected route according to the new preferences.

Cut/Copy/Paste – Like the functions in the Edit Menu, these options allow you to cut, copy and
paste routes.

Delete Route – Deletes the selected route.

Show Selected Route on Map – Zooms to the selected route and centers it on the Graphic Map.

Route Properties – Activates the Route Properties window, allowing you to review and edit the
properties for the selected route.  See Setting Route Preferences for more information.
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Favorite Finds Right-Click Menu
When you right-click on an item in the Favorite Finds Tab, the following options are displayed:

Activate Favorite Find – Activates the selected Favorite Find.  See Finding an Item Using the
Favorite Finds Feature for more information.

Delete Favorite Find – Deletes the selected Favorite Find.

Favorite Find Properties – Activates the Favorite Find Properties window for the selected Favorite
Find.  See Editing a Favorite Find for more information.

New Favorite Find – Creates a new favorite find.  See Adding an Item to Your Favorite Finds  for
more information.
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Tracks Right-Click Menu
When you right-click on a track on the Graphic Map or a track name in the Tracks Tab, the following
options may be displayed:

Route To It – Creates a route from your current location to the selected map location.  See
Understanding Routes for more information.

Find Nearest Places – Locates the features closest to the point you click on.  See Finding Items Near
Your Current Location for more information.

New Waypoint – Creates a new waypoint at the selected map location and accesses the ‘Waypoint
Properties’ dialog.  See Understanding Waypoints for more information.

Begin Measurement – Activates the Distance/Bearing Tool, allowing you to measure the distance and
bearing from one point to another on the Graphic Map.  With the Distance/Bearing Tool selected,
click on a point on the Graphic Map, then click on the point on the map you want to find the
distance/bearing to.  The distance and bearing between the two points are shown in the Status Bar at
the bottom of the nRoute application window.  To stop using the Distance/Bearing Tool, press the
Esc key on your keyboard or select a different tool.

Cut/Copy/Paste – Like the functions in the Edit Menu, these options allow you to cut, copy and
paste tracks.

Delete Track – Deletes the selected track.

Set New Location – If your GPS is not activated or has not acquired satellites, this option allows you
to set your current location to the appropriate place on the Graphic Map, which allows your GPS to
acquire satellites faster.  After your GPS acquires satellites, nRoute identifies your current location and
marks it with the Vessel icon on the Graphic Map.

Show Selected Track on Map – Zooms to the selected track and center it on the Graphic Map.

Track Properties – Activates the Track Properties window, allowing you to review and edit the
properties for the selected track.  See Editing Track Properties for more information.



98

Index

A

About nRoute.....................................................................................................................................................................1, 91
Accuracy ................................................................................................................................................................. 3, 4, 12, 13

of GPS .................................................................................................................................................................................12
of Map Data...........................................................................................................................................................................2

Activating ...........................................................................................................................................................................9, 67
Favorite Finds .....................................................................................................................................................................96
Information Tabs...................................................................................................................................................................9
Saved Routes .......................................................................................................................................................... 66, 67, 95
Toolbars ..........................................................................................................................................................................9, 86

Activating and Deactivating a Route .......................................................................................................................................67
Active Routes ............................................................................................................................................................ 58, 61, 65
Active Track Filter..................................................................................................................................................... 73, 74, 78

Setting .................................................................................................................................................................................74
Active Track Properties ....................................................................................................................................................72, 76

Viewing ...............................................................................................................................................................................76
Active Tracks....................................................................................................................................................................76, 77

Recording ............................................................................................................................................................................75
Adding an Item to Your Favorite Finds ..................................................................................................................................54
Adding Via Points to Routes .............................................................................................................................................63, 69
Addresses .................................................................................................................................................................. 25, 42, 45

Closest to Your Current Location ........................................................................................................................................25
Creating Routes to ...............................................................................................................................................................62
Finding................................................................................................................................................................................45

Altitude/Elevation...................................................................................................................................................................14
of Waypoints .................................................................................................................................................................34, 37

Areas ......................................................................................................................................................................................14
Arrow Keys ............................................................................................................................................................................19
Attempting Connection to Unit ........................................................................................................................................11, 23
Attention Tone .......................................................................................................................................................................15
Auto Complete ......................................................................................................................................... 41-43, 45, 46, 48, 50
AutoDetect .............................................................................................................................................................................11
Automatic Magnetic Variation ................................................................................................................................................14
Automatically Zooming ..........................................................................................................................................................21
Autoname.................................................................................................................................................................. 63, 69, 95
Auto-Routes .............................................................................................................................................................. 14, 58, 60

B

Basemap................................................................................................................................................................ 9, 10, 16, 42
Begin Measurement ..........................................................................................................................................................93, 94
Buttons.............................................................................................................................................................................81, 82

C

Cardinal Direction..................................................................................................................................................................14
Cartography .........................................................................................................................................................................3, 4
Cautions...................................................................................................................................................................................2
Centering .........................................................................................................................................................................16, 33

On a City.............................................................................................................................................................................42
On a Map Feature/Point of Interest......................................................................................................................................43
On a Waypoint..............................................................................................................................................................33, 47
On an Address.....................................................................................................................................................................45
On an Intersection...............................................................................................................................................................46
On the Vessel Icon ..............................................................................................................................................................16

Changing Map Orientation........................................................................................................................................ 22, 81, 86
Checking Satellite Status ........................................................................................................................................................12
Cities......................................................................................................................................................................................42



99

Creating Routes to ...............................................................................................................................................................62
Finding................................................................................................................................................................................42

Colors ....................................................................................................................................................................................18
Common Tasks ........................................................................................................................................................................7
Compass ................................................................................................................................................................................25
Computer.........................................................................................................................................................................1, 4, 5

Trip Computer ....................................................................................................................................................................26
Connecting the GPS Receiver .......................................................................................................................................7, 11, 12
Connection Status ..................................................................................................................................................................12
Containing Field ....................................................................................................................................................... 40, 48, 54
Copy ......................................................................................................................................................................................85
Corners ..................................................................................................................................................................................46
Creating Routes................................................................................................................................................................ 60-63

To Multiple Points...............................................................................................................................................................63
Using the Find Places Feature................................................................................................................ 42, 43, 45-48, 50, 63
Using the Route Properties Window....................................................................................................................................85
Using the Selection Tool......................................................................................................................................................61

Creating Waypoints..........................................................................................................................................................35, 36
Using the Find Places Feature............................................................................................................... 42, 43, 45, 46, 48, 50

Current Status ..............................................................................................................................................................9, 23, 25
Customer Service .....................................................................................................................................................................2
Customizing...........................................................................................................................................................................18
Cut.........................................................................................................................................................................................85

D

Datum....................................................................................................................................................................................14
Day and Night Settings...........................................................................................................................................................18
Deactivating a Route...........................................................................................................................................................7, 67
Deleting................................................................................................................................... 7, 33, 39, 57, 71, 72, 80, 96, 97

Favorite Finds ...............................................................................................................................................................57, 96
Routes .............................................................................................................................................................................8, 71
Tracks ................................................................................................................................................................ 8, 72, 80, 97
Waypoints .................................................................................................................................................................8, 33, 39

Depth .....................................................................................................................................................................................14
Direct Routes............................................................................................................................................................. 25, 58, 60
Directions...........................................................................................................................................................................9, 68
Disclaimer ................................................................................................................................................................................2
Display ...................................................................................................................................................... 9, 14, 34, 68, 73, 79

Main nRoute Display .............................................................................................................................................................9
Preferences .................................................................................................................................................................... 14-16
Routes ...........................................................................................................................................................................60, 68
Setting Preferences ..............................................................................................................................................................18
Tracks ...........................................................................................................................................................................73, 79
Waypoints .....................................................................................................................................................................34, 35

Distance ...........................................................................................................................................................................14, 25
Distance/Bearing Tool ......................................................................................................................................... 81, 89, 93, 94
Distance/Speed.......................................................................................................................................................... 14, 23, 25
Driving Directions ........................................................................................................................................ 7, 8, 61, 63, 68-70

Driving Directions Information Tab.....................................................................................................................................68
Printing .........................................................................................................................................................................63, 69

Driving Speeds .......................................................................................................................................................... 23, 25, 60
Duplicate Route................................................................................................................................................................85, 95

E

Edit Menu ..............................................................................................................................................................................85
Edit Toolbar .....................................................................................................................................................................81, 85
Editing .................................................................................................................................................... 33, 37, 56, 72, 78, 85

Favorite Finds .....................................................................................................................................................................56
Routes .................................................................................................................................................................................69
Tracks .................................................................................................................................................................................78
Waypoint Properties............................................................................................................................................................37



100

Elevation ................................................................................................................................................................................25
of Waypoints .................................................................................................................................................................34, 37

Email........................................................................................................................................................................................1
Error Reporting ........................................................................................................................................................................4
ETA..................................................................................................................................................................................24, 25

To Destination...............................................................................................................................................................23, 25
To Maneuver .................................................................................................................................................................23, 25

Exit ........................................................................................................................................................................................84
Exporting Files .................................................................................................................................................................27, 84

F

F Keys ......................................................................................................................................................................................9
Faster Time ............................................................................................................................................................................60
Fathoms .................................................................................................................................................................................14
Favorite Finds ............................................................................................................................................................ 52-57, 96

Adding ................................................................................................................................................................................54
Deleting...............................................................................................................................................................................57
Editing.................................................................................................................................................................................56
Favorite Finds Information Tab ...........................................................................................................................................53
Favorite Finds Right-Click Menu.........................................................................................................................................96
Finding................................................................................................................................................................................55
Properties ............................................................................................................................................................................96

File Menu...............................................................................................................................................................................84
Find ........................................................................................................................................................... 7, 14, 15, 40-57, 96

Addresses ........................................................................................................................................................................7, 45
Basemap ..............................................................................................................................................................................40
Cities .............................................................................................................................................................................40, 42
Creating Routes Using the Find Places Feature ....................................................................................................................62
Favorite Finds ......................................................................................................................................................... 52-57, 96
Find Menu.............................................................................................................................................................. 40, 83, 87
Find Toolbar .......................................................................................................................................................... 40, 81, 87
Intersections ..............................................................................................................................................................7, 40, 46
Items Near Your Current Location.................................................................................................................................40, 48
Items on the Map ..................................................................................................................................................................7
Last Found Place .................................................................................................................................................................87
Latitude/Longitude Position.................................................................................................................................................51
Map Features/Points of Interest .....................................................................................................................................40, 43
Nearest Places....................................................................................................................................... 40, 48, 49, 81, 87, 93
Places ............................................................................................................................................................................40, 87
Points of Interest .................................................................................................................................................................43
Preferences ............................................................................................................................................................. 14, 40, 41
Recently Found Places............................................................................................................................................ 40, 50, 87
Understanding.....................................................................................................................................................................40
Waypoints ...........................................................................................................................................................................47

Function Keys ..........................................................................................................................................................................9

G

Garmin................................................................................................................................................................................. 1-6
Consent of .............................................................................................................................................................................2
Corporation...........................................................................................................................................................................2
Garmin International .....................................................................................................................................................2, 4, 5
Garmin Ltd........................................................................................................................................................................2, 4
GPS ...................................................................................................................................................................................1, 2
MapSource ......................................................................................................................................................................1, 10
nRoute...................................................................................................................................................................................1
Product Support ............................................................................................................................................................1, 4, 6

Global Positioning System........................................................................................................................................................3
Go To Position .................................................................................................................................................................51, 86
GPS ............................................................................................................................................................. 2, 3, 11, 12, 23, 24

Connecting.................................................................................................................................................................... 11-13
Getting GPS Information .....................................................................................................................................................90



101

Initializing .....................................................................................................................................................................12, 93
Map Detail...........................................................................................................................................................................86
Selecting ........................................................................................................................................................................11, 90

Graphic Map ........................................................................................................................................ 9, 16, 18-22, 33, 34, 38
Changing.......................................................................................................................................................................18, 22
Finding Items on ................................................................................................................................... 40, 42, 43, 45-48, 50
Moving ................................................................................................................................................................................19
Moving Waypoints on .........................................................................................................................................................38
Orientation..........................................................................................................................................................................22
Showing the Vehicle on .......................................................................................................................................................21
Showing Waypoints on .................................................................................................................................................33, 34
Tips .....................................................................................................................................................................................16
Understanding.....................................................................................................................................................................16
Zooming In and Out............................................................................................................................................................20

Grid .................................................................................................................................................................................14, 15

H

Hand Tool........................................................................................................................................................................19, 89
Heading............................................................................................................................................................................14, 25
Help Menu .............................................................................................................................................................................91
Hide ...................................................................................................................................................................................9, 18

I

Important Information .............................................................................................................................................................2
Importing Files.................................................................................................................................................................28, 84
InfoBar .................................................................................................................................................................. 9, 11, 14, 23

Preferences ..........................................................................................................................................................................14
Using...................................................................................................................................................................................23

Information Tabs....................................................................................... 9, 12, 16, 25, 26, 34, 53, 66, 68, 73, 86, 92, 96, 97
Driving Directions Tab ........................................................................................................................................................68
Favorite Finds Tab.........................................................................................................................................................53, 96
Satellites Tab .......................................................................................................................................................................12
Saved Routes Tab ................................................................................................................................................................66
Showing/Hiding ..................................................................................................................................................................86
Status Tab............................................................................................................................................................................25
Tracks Tab................................................................................................................................................... 72, 73, 75-80, 97
Trip Computers Tab............................................................................................................................................................26
Using.....................................................................................................................................................................................9
Waypoints Tab ....................................................................................................................................................................34

Initializing the GPS Receiver.............................................................................................................................................11, 12
Installing nRoute ..................................................................................................................................................................1, 2
Interface .............................................................................................................................................................................9, 23
Intersections...........................................................................................................................................................................46

Creating Routes to .........................................................................................................................................................62, 63
Finding................................................................................................................................................................................46

Inverting ................................................................................................................................................................... 69, 78, 96
Routes .............................................................................................................................................................. 63, 64, 69, 96
Tracks .................................................................................................................................................................................78

Items Near Your Current Location .........................................................................................................................................48

K

Keep Both Visible .............................................................................................................................................................21, 86
Keep Next Maneuver Visible ..................................................................................................................................... 21, 22, 86
Keep Vessel Visible.............................................................................................................................................. 17, 21, 22, 86

L

Last Found Place ..............................................................................................................................................................50, 87
Latitude..............................................................................................................................................................................9, 51
Legend ....................................................................................................................................................................... 29, 30-32

Businesses and Attractions...................................................................................................................................................29
Map Areas ...........................................................................................................................................................................32



102

Map Lines............................................................................................................................................................................31
Points of Interest .................................................................................................................................................................30

License Agreement ...................................................................................................................................................................4
Limit Waypoint Name............................................................................................................................................................35
Lists..........................................................................................................................................................................................9

Favorite Finds .......................................................................................................................................................................9
Saved Routes .........................................................................................................................................................................9
Tracks ...................................................................................................................................................................................9
Waypoints .............................................................................................................................................................................9

Lock to Roads.........................................................................................................................................................................18
Longitude...........................................................................................................................................................................9, 51

M

Map Feature Right-Click Menu ..............................................................................................................................................93
Map Features/Points of Interest ..............................................................................................................................................43

Creating Routes to .........................................................................................................................................................61, 62
Finding................................................................................................................................................................................43

Map Orientation...............................................................................................................................................................16, 22
Changing.............................................................................................................................................................................22

Map Scale Selector..................................................................................................................................................................20
Maps ............................................................................................................................................. 9, 10, 16, 19, 20, 31, 32, 43

Changing Map Font.............................................................................................................................................................18
Detailed Data.......................................................................................................................................................... 16, 18, 43
Map Areas ...........................................................................................................................................................................32
Map Data Information ...........................................................................................................................................................3
Map Features.......................................................................................................................................................................43
Map Lines............................................................................................................................................................................31
Moving ................................................................................................................................................................................17
Showing Map Detail ......................................................................................................................................................14, 18
Unlocking........................................................................................................................................................................7, 10

MapSource ...................................................................................................................................................... 2, 10, 16, 27, 28
Opening .Mps Files .............................................................................................................................................................28
Saving Data as MapSource Files...........................................................................................................................................27
Selecting a Mapsource Product ............................................................................................................................................85
Unlocking......................................................................................................................................................................10, 90

Mark Current Position............................................................................................................................................................90
Marking Waypoints................................................................................................................................................... 33, 35, 36
Maximum Search Distance ...............................................................................................................................................48, 52
Menus .......................................................................................................................................................................... 9, 84-91

Edit Menu ...........................................................................................................................................................................85
File Menu ............................................................................................................................................................................84
Find Menu...........................................................................................................................................................................87
Help Menu ..........................................................................................................................................................................91
Route Menu.........................................................................................................................................................................88
Tools Menu .........................................................................................................................................................................89
Utilities Menu......................................................................................................................................................................90
View Menu ..........................................................................................................................................................................86

Meters ..............................................................................................................................................................................14, 15
Mileage...................................................................................................................................................................................26
Miles ......................................................................................................................................................................................15
Minus Key..............................................................................................................................................................................20
Mounting the GPS....................................................................................................................................................................2
Moving the Graphic Map..................................................................................................................................................16, 19
Moving Waypoints ...........................................................................................................................................................38, 94
Mps Files......................................................................................................................................................................7, 27, 28

Opening ..............................................................................................................................................................................28
Saving Routes as ..................................................................................................................................................................27
Saving Tracks as ............................................................................................................................................................27, 72
Saving Waypoints as......................................................................................................................................................27, 33

Multiple Points on the Graphic Map.................................................................................................................................16, 93



103

N

Name Prefix ...........................................................................................................................................................................35
NAVAIDs .................................................................................................................................................................................2
Navigation.................................................................................................................................................................. 14-16, 68

Preferences ..........................................................................................................................................................................14
Next Street .......................................................................................................................................................................23, 25
North Up .........................................................................................................................................................................16, 22
NRoute.........................................................................................................................................................................1, 10, 91

Interface ................................................................................................................................................................................9
Software Version..................................................................................................................................................................91

O

Odometer...............................................................................................................................................................................26
Off-Route Recalculation .........................................................................................................................................................14
Opening a Saved .mps File ...............................................................................................................................................27, 28

P

Paste.......................................................................................................................................................................................85
Plus Key .................................................................................................................................................................................20
Points of Interest ..................................................................................................................................... 16, 18, 29, 30, 43, 48

Creating Routes to .................................................................................................................................................. 43, 62, 63
Finding................................................................................................................................................................................43
Finding the Nearest .............................................................................................................................................................48
Legend ..........................................................................................................................................................................29, 30
Showing on the Map ...........................................................................................................................................................18
Symbols.........................................................................................................................................................................29, 30

Position ...................................................................................................................................................... 9, 12-16, 34, 37, 51
Current..................................................................................................................................................................................9
Format...........................................................................................................................................................................14, 15
Go to ...................................................................................................................................................................................51
Of Mouse Cursor...................................................................................................................................................................9
Of Waypoint .......................................................................................................................................................................34
Preferences ..........................................................................................................................................................................14

Preferences ........................................................................................................................ 9, 14, 16, 18, 33, 35, 41, 60, 74, 85
Changing.........................................................................................................................................................................9, 41
Display ................................................................................................................................................................................18
Find.....................................................................................................................................................................................41
Route...................................................................................................................................................................................60
Setting ...........................................................................................................................................................................14, 15
Waypoint ......................................................................................................................................................................33, 35

Printing ..................................................................................................................................................................................84
Driving Directions .........................................................................................................................................................63, 69
The Graphic Map ................................................................................................................................................................84

Problems ..........................................................................................................................................................................11, 12
With GPS ............................................................................................................................................................................12
With Mouse.........................................................................................................................................................................11

Product Selector ........................................................................................................................................................ 10, 81, 86
Properties ................................................................................................................................................ 33, 34, 37, 76, 78, 85

Route Properties ............................................................................................................................................... 63, 66, 69, 85
Track Properties ............................................................................................................................................... 73, 76, 78, 85
Waypoint Properties......................................................................................................................................... 33, 34, 37, 85

Proximity ...............................................................................................................................................................................34

Q

Quick Instructions ...................................................................................................................................................................7

R

Recalculating a Route .......................................................................................................................................... 14, 81, 88, 95
Recently Found Places......................................................................................................................................... 41, 50, 62, 87



104

Recording the Active Track .......................................................................................................................................... 7, 72-78
Redo.......................................................................................................................................................................................85
Regions ..................................................................................................................................................................................10
Removing Waypoints from a Route ........................................................................................................................................69
Renaming USB GPS................................................................................................................................................................90
Renaming Waypoints .............................................................................................................................................................37
Right-Click Menus ......................................................................................................................................... 34, 61, 73, 93-97

Favorite Finds Right-Click Menu.........................................................................................................................................96
Map Feature Right-Click Menu............................................................................................................................................93
Saved Routes Right-Click Menu...........................................................................................................................................95
Tracks Right-Click Menu...............................................................................................................................................73, 97
Waypoint Right-Click Menu..........................................................................................................................................34, 94

Roads ...........................................................................................................................................................................2, 16, 60
Routes ...................................................................................................................................................... 16, 18, 27, 28, 58-71

Activating and Deactivating a Route ....................................................................................................................... 66, 67, 88
Active Routes.......................................................................................................................................................................67
Adding Via Points to......................................................................................................................................................63, 69
Autonaming...................................................................................................................................................................63, 69
Autorouting.........................................................................................................................................................................60
Calculation Style..................................................................................................................................................................60
Creating Routes Using the Route Properties Window ..........................................................................................................63
Creating Using the Find Feature..................................................................................................... 42, 43, 45, 46, 47, 48, 50
Deleting........................................................................................................................................................ 7, 66, 71, 81, 85
Direct ..................................................................................................................................................................................60
Driving Directions for............................................................................................................................................. 63, 68, 70
Editing.................................................................................................................................................................................69
Inverting........................................................................................................................................................................63, 69
Recalculating .................................................................................................................................................... 58, 69, 81, 88
Removing Waypoints from a Route .....................................................................................................................................69
Resume Route......................................................................................................................................................................82
Route Menu.........................................................................................................................................................................88
Route Properties ............................................................................................................................................................63, 69
Route Tips ...........................................................................................................................................................................58
Route To It ....................................................................................................................................................................93, 94
Route Toolbar......................................................................................................................................................................82
Saved Routes .............................................................................................................................................. 63, 65, 67, 69, 88
Saved Routes Information Tab.............................................................................................................................................66
Saving................................................................................................................................................................. 7, 27, 28, 65
Showing on the Map .....................................................................................................................................................63, 69
Stopping Navigation............................................................................................................................................................88
To Multiple Points...............................................................................................................................................................63
Vias ...............................................................................................................................................................................63, 69

S

Satellite Status ..............................................................................................................................................................7, 11, 12
Satellites Information Tab...................................................................................................................................................7, 12
Saved Routes ............................................................................................................................... 59, 63, 65, 66, 67, 71, 85, 95

Activating ............................................................................................................................................................... 58, 59, 67
Deleting...........................................................................................................................................................................7, 71

Saving ................................................................................................................................................................. 27, 28, 65, 77
.MPS files.............................................................................................................................................................................27
Active Routes.......................................................................................................................................................................65
Active Tracks.......................................................................................................................................................................77
Map Information .......................................................................................................................................................7, 16, 27
Opening Saved Files ............................................................................................................................................................28
Routes .............................................................................................................................................................................7, 27
Tracks .......................................................................................................................................................... 7, 27, 72, 73, 77
Waypoints .................................................................................................................................................................7, 27, 33

Scroll Bars ..............................................................................................................................................................................19
Searching for Satellites .....................................................................................................................................................11, 23
Select Device ..........................................................................................................................................................................11
Select GPS ..............................................................................................................................................................................90



105

Selecting a Mapsource Product.........................................................................................................................................10, 85
Selection Tool ......................................................................................................................................... 16, 38, 61, 81, 89, 93

Creating Routes Using .........................................................................................................................................................61
Creating Waypoints Using...................................................................................................................................................93
Moving Waypoints Using ....................................................................................................................................................38

Sensor Configuration..............................................................................................................................................................11
Serial GPS...............................................................................................................................................................................11
Services ..................................................................................................................................................................................18
Set New Location .............................................................................................................................................................11, 93
Set PC Clock ..........................................................................................................................................................................90
Setting Preferences ........................................................................................................................................ 14, 18, 23, 33, 85

Display Preferences........................................................................................................................................................16, 18
Find Preferences ..................................................................................................................................................................41
InfoBar Preferences........................................................................................................................................................14, 23
Navigation Preferences ........................................................................................................................................................14
Position Preferences.............................................................................................................................................................14
Routing Preferences .............................................................................................................................................................60
Time Preferences .................................................................................................................................................................14
Units Preferences.................................................................................................................................................................14
Waypoint Preferences....................................................................................................................................................33, 35

Setting the Active Track Filter ................................................................................................................................... 72, 74, 78
Setup Guide .........................................................................................................................................................................1, 7
Shortcuts............................................................................................................................................................................7, 92

Right-Click Menus...............................................................................................................................................................92
Shorter Distance.....................................................................................................................................................................60
Show Crosshair ......................................................................................................................................................................86
Show Information Tabs ..........................................................................................................................................................86
Showing Items on the Map.................................................................................................... 16, 34, 37, 66, 69, 73, 76, 79, 86

Showing Routes................................................................................................................................................ 63, 66, 68, 69
Showing the Next Maneuver ...............................................................................................................................................21
Showing the Selected Item.............................................................................................................................................16, 86
Showing the Vehicle ............................................................................................................................................... 16, 21, 58
Showing Tracks ................................................................................................................................................ 18, 73, 76, 79
Showing Waypoints ......................................................................................................................................................34, 37

Software Agreement .................................................................................................................................................................4
Space Bar............................................................................................................................................................... 7, 14, 58, 90
Speak .............................................................................................................................................................. 8, 15, 58, 82, 90
Specifications ...........................................................................................................................................................................1
Speed ......................................................................................................................................................................... 14, 23-26
Square Feet ............................................................................................................................................................................15
Square Kilometer....................................................................................................................................................................14
Status .....................................................................................................................................................................................12

of GPS Connection ..............................................................................................................................................................12
of Satellites ..........................................................................................................................................................................12

Status Bar .....................................................................................................................................................................9, 16, 86
Status Information Tab...........................................................................................................................................................25
Stop Route ............................................................................................................................................................ 7, 67, 82, 88
Stopping Navigation.............................................................................................................................................. 7, 67, 81, 88
Streets ..............................................................................................................................................................................45, 46
Switch Maps.............................................................................................................................................................. 10, 81, 86
Symbols ..................................................................................................................................................................... 16, 29-32

For Waypoints.....................................................................................................................................................................35

T

Tabs .............................................................................................................................................. 9, 25, 26, 34, 53, 66, 68, 73
Driving Directions ...............................................................................................................................................................68
Favorite Finds .....................................................................................................................................................................53
Saved Routes .......................................................................................................................................................................66
Showing/Hiding ..............................................................................................................................................................9, 86
Status ..................................................................................................................................................................................25
Tracks .................................................................................................................................................................................73
Trip Computers...................................................................................................................................................................26



106

Waypoints ...........................................................................................................................................................................34
Technical Specifications ...........................................................................................................................................................1
Terms and Conditions..............................................................................................................................................................2
Time............................................................................................................................................................... 13-15, 23, 24, 26

Preferences ..........................................................................................................................................................................14
To Next Maneuver...............................................................................................................................................................23
Total....................................................................................................................................................................................24

Tips....................................................................................................................................................................... 7, 16, 33, 58
Toolbars ................................................................................................................................................................ 9, 81, 82, 86

Showing/Hiding ........................................................................................................................................................9, 81, 86
Undocking ..........................................................................................................................................................................82

Tools Menu ............................................................................................................................................................................89
Track Filter ............................................................................................................................................................... 72, 74, 78
Track Up..........................................................................................................................................................................16, 22
Tracks ...................................................................................................................................................... 16, 18, 27, 72-80, 97

Deleting.............................................................................................................................................................. 7, 72, 80, 97
Editing...........................................................................................................................................................................72, 78
Information Tab ............................................................................................................................................................ 72-80
Inverting..............................................................................................................................................................................97
Points ..................................................................................................................................................................... 72, 74, 76
Properties ......................................................................................................................................................... 73, 76, 78, 97
Recording ..................................................................................................................................................................8, 72, 73
Right-Click Menu ................................................................................................................................................................97
Saving..............................................................................................................................................................................7, 27
Showing on the Graphic Map ..............................................................................................................................................18
Showing on the Map ...........................................................................................................................................................97
Understanding.....................................................................................................................................................................72
Viewing .........................................................................................................................................................................72, 79

Trip Computers Information Tab ...........................................................................................................................................26
Troubleshooting...............................................................................................................................................................11, 12

GPS ...............................................................................................................................................................................12, 13
Mouse..................................................................................................................................................................................11

U

Understanding .......................................................................................................................................... 9, 16, 33, 52, 58, 72
Favorite Finds Feature.........................................................................................................................................................52
Find Places Feature .............................................................................................................................................................40
Graphic Map .................................................................................................................................................................16, 17
Interface ................................................................................................................................................................................9
Routes .................................................................................................................................................................................58
Tracks .................................................................................................................................................................................72
Waypoints ...........................................................................................................................................................................33

Undo......................................................................................................................................................................................85
Undocking the Toolbars.........................................................................................................................................................82
Units ......................................................................................................................................................................................14
Unlocking Maps ...............................................................................................................................................................10, 90
USB GPS ..........................................................................................................................................................................11, 90

Drivers.................................................................................................................................................................................90
Using the Favorite Finds Tab .................................................................................................................................................53
Using the InfoBar .............................................................................................................................................................16, 23
Using the Saved Routes Tab ...................................................................................................................................................66
Using the Status Tab ..............................................................................................................................................................25
UTC offset..............................................................................................................................................................................15
Utilities Menu...................................................................................................................................................................10, 90
Utilities Toolbar .....................................................................................................................................................................11
U-Turns .................................................................................................................................................................................60

V

Vehicle .............................................................................................................................................................................17, 21
Showing on the Map ...........................................................................................................................................................21

Vehicle Operation ....................................................................................................................................................................2



107

Vessel Icon ...................................................................................................................................................... 9, 16, 18, 21, 22
Vessel Size..............................................................................................................................................................................18
Vias ..................................................................................................................................................................................59, 63

Adding to a Route................................................................................................................................................................63
View Menu.......................................................................................................................................................................20, 86
View Toolbar............................................................................................................................................................. 10, 16, 81
Viewing................................................................................................................................................................. 9, 72, 76, 79

Active Track Properties..................................................................................................................................................72, 76
Graphic Map .........................................................................................................................................................................9
Tracks ...........................................................................................................................................................................72, 79

Voice Prompts..................................................................................................................................................................15, 90
Getting the Voice to Speak ................................................................................................................................. 7, 58, 81, 90

W

WAAS ..............................................................................................................................................................................12, 13
Warranty..............................................................................................................................................................................4, 6
Waypoints.................................................................................................................................... 15, 16, 27, 33-35, 37, 39, 47

Centering on .......................................................................................................................................................... 33, 37, 94
Creating.........................................................................................................................................................................35, 36
Creating Routes to .................................................................................................................................................. 62, 63, 94
Creating Using the Find Places Feature ................................................................................................ 42, 43, 45, 46, 48, 50
Deleting.....................................................................................................................................................................7, 33, 39
Displaying .............................................................................................................................................................. 33, 35, 94
Finding................................................................................................................................................................................47
Marking.................................................................................................................................................................. 33, 36, 93
Moving ..........................................................................................................................................................................38, 94
Preferences ..........................................................................................................................................................................14
Properties ......................................................................................................................................................... 33, 36, 37, 38
Renaming ............................................................................................................................................................................37
Right-Click Menu ................................................................................................................................................................34
Saving..............................................................................................................................................................................8, 27
Selecting ................................................................................................................................................................. 33, 34, 93
Setting Preferences ..............................................................................................................................................................35
Showing on the Map .....................................................................................................................................................37, 94
Symbols...............................................................................................................................................................................37
Tool........................................................................................................................................................................ 36, 81, 89
Understanding.....................................................................................................................................................................33
Waypoints Information Tab ................................................................................................................................................34

Welcome..................................................................................................................................................................................1
www.garmin.com.................................................................................................................................................................1, 2

Z

Zoom .................................................................................................................................................................... 7, 19, 20, 86
Scale ..............................................................................................................................................................................20, 86
Tool........................................................................................................................................................................ 20, 81, 89
Zoom In Max.......................................................................................................................................................................86
Zoom Out Region................................................................................................................................................................86

Zooming In and Out ............................................................................................................................................. 7, 19, 20, 86



© Copyright 2004 Garmin Ltd. or its subsidiaries

Garmin International, Inc.
1200 East 151st Street, Olathe, Kansas  66062, U.S.A.

Garmin (Europe) Ltd.
Unit 5, The Quadrangle, Abbey Park Industrial Estate, Romsey, SO51 9DL, U.K.

Garmin Corporation
No. 68, Jangshu 2nd Road, Shijr, Taipei County, Taiwan

www.garmin.com

                                                                            Part Number 190-00308-00 Rev. A                                           




